
ManagePro Help Index

 Getting started

 Step by step procedures
Planning your goals
Tracking your people and teams
Organizing yourself and your time
Printing your reports
Customizing ManagePro
Using ManagePro

 Pull-down commands

 ManagePro Windows

 Buttons
View Bar
Related View buttons
Tool Bar

 Troubleshooting

 Special topics

 New Features
For information on how to use Help, press F1 or choose Help Using Help.



View Bar
The View Bar contains primary Related View buttons that open textual or graphic windows of
database information. The buttons, from left to right, are the same as choosing the 
commands, from top to bottom, from the View menu. Most windows that you open using 
these buttons also offer a combination of Tool and Related View button area.

Goal Planner Displays a text window for adding to and working with your overall 
goals.

Goal Timeline Displays a timeline view of the Goal Planner information with timeline 
bars that show the duration of your goals.

Goal Status Board Displays a graphics window for managing goals.
People/Team Planner Displays a text window for adding and working with people and 

team information.
People Status Board Displays current status of individual goals and people 

management activities.
To Do List Displays a text window for viewing and working with your to do items.
Action List Displays a text window for viewing and working with your action items.
Global Calendar Displays a graphics window for viewing and working with your action 

items.
AssistantDisplays a window for viewing Goals, People and Actions in one place for quick

review.
Reports Planner Displays a window for selecting reports to print to the printer, to a file 

or to the screen from the people, goals or action item windows.
Advisor Displays the Management Advisor for the currently active window.



Related View buttons
Related View buttons appear on the left side of each window. These buttons opens a window 
that contains more detailed information. They change depending upon which window is 
active and which usage style you have selected.

Choose a specific Goal, then click on these buttons to get more information sorted by goal.

Displays any related Goal Progress Data.
Displays any related Goal Progress To Do items.
Displays any related Goal Progress Data Details.
Displays any related notes.
Displays any Goal Progress attached documents.

Choose a specific person or team, then click on these buttons to get more information sorted
by person or team.

Displays the person or teams related goals.
Displays the person or teams related progress.
Displays the person or teams related feedback and coaching details.
Displays the person or teams related performance appraisals and reviews.
Displays the person or teams related recognition.
Displays the person or teams related development plans.
Displays the person or teams related commitments.
Displays the person or teams related calendar.
Displays the person or teams related To Do list.
Displays the person or teams related details.
Displays the person or teams related notes.
Displays the person or teams attached documents.

Action

Displays a new To Do Item Details window where you can add an action item.
Displays a new Event window where you can add an event.

bmc commita.bmp} Displays a new Commitment window where you can add a 
commitment.

Displays any details about the specified action item, event or commitment.
Displays any notes about the specified action item, event or commitment,.
Displays any attached documents about the specified action item, event or 

commitment.



Tool Bar
The Tool Bar appears at the top of each window (unless you change this position using the 
Display command from the Options menu.) When you click a Tool button, you take a specific 
action on the contents of the current window. For example, there are Tool buttons to sort 
information in the current window or to print its contents.

Close Closes the active window.
Find Searches for a specific item such as a goal title, status and so on, and find it in

the active window.
Filter Selects display information that meets conditional criteria that you specify. 

Planner views let you save filters so you can easily reapply them later.
Sort Rearranges rows in a window, sorting by one or two fields. Planner views let 

you save sorts so you can easily reapply them later. For example, you might sort Bills goals 
by Priority and Status.

Configure Changes how your information is displayed.
Mail Sends an electronic mail message to the person or people indicated in the 

selected item. If you have not yet specified the kind of mail system you use, a window 
appears asking you to specify which mail system you use first.

Print Prints the contents of the active window.
View As Selects one of the available views for the active window.
Promote  (available with windows that offering outlining, such as the Goal Planner 

summary table) let you move the selected entry up a level in the hierarchical list.
Demote (available with windows that offering outlining, such as the Goal Planner 

summary table) let you move the selected entry down a level in the hierarchical list.



Windows
Goal Planner Displays a text window for adding and working with your overall goals.
Goal Timeline Displays a timeline view of the Goal Planner information with timeline 

bars that show the duration of your goals.
Goal Status Board Displays a graphics window for managing goals.
People/Team Planner Displays a text window for adding and working with people and team 

information.
People Status Board Displays a graphics window for managing people. A colored triangle 

appears just right of the People Status Board button in the View bar if 
the status of one of your people management activities is approaching 
or becomes overdue.

To Do List Displays a text window for viewing and working with your to do items.
Action List Displays a text window for viewing and working with your action items. 
Calendar Displays a graphics window for viewing and working with your action 

items. The calendar gives you year-, month- and week and day-at-a-
glance views of all of your action items.

Assistant Lets you see ManagePros three areas of focus: goals, people, and 
actions information in a single place. It allows you to easily pinpoint 
items that need attention, such as goals that are critical or overdue.

Reports Planner Lets you select reports to print to the printer, to a file or to the screen 
from the people, goals or action item windows. 

Advisor Displays the Management Advisor section for the active window. 



File Utilities Synchronize this mobile data with base
Lets you update an extracted database with information that has been subsequently 
changed in the database on the primary computer or network.
This command has a dialog box. 
_________
Related topics

Extracted database, synchronizing with the base database or vice versa



File Utilities Synchronize this file with mobile data
Lets you update the database on the primary computer or network with changes made to 
the extracted database used for mobile computing.
This command has a dialog box. 
_________
Related topics

Extracted database, synchronizing with the base database or vice versa



Synchronize - Resolve items dialog box
See also Synchronize this file with mobile data for overview and related topics.



These items have conflicts
Select one or more of the conflicting fields, such as a goal, that has been changed both on 
the road and in the base database.



Resolve item
Displays the Synchronize - Resolve Fields dialog box to begin the process of resolving the 
field information conflict.



E-mail
Sends E-mail to the people involved in this conflicting entry.



Print
Prints information on this conflicting entry.



View item
Displays information about the conflict field.



Done
Merges the two databases when you have resolved the conflicts. Any conflicts you put on 
hold are stored and available for a later merge.



Synchronize - Resolve fields dialog box
See also Synchronize this file with mobile data for overview and related topics.



Fields for ...
Lists the fields that have conflicts. 



E-mail
Sends E-mail to the people involved in this conflicting entry.



Print
Prints information on this conflicting entry.



View item
Displays information about the conflict field.



Mobile Information
Displays the mobile database details for the field you selected in Fields for ...



Base Information
Displays the base database details for the field you selected in Fields for ...



Choose Option
Select whether you want to use the Mobile or Base information for the field you selected in 
Fields for..., or whether you want to place this field conflict on hold.



More details
Displays more information depending on the context of what you are working with. For 
example, if you are viewing a parent goal, ManagePro shows you all of its subgoals. If you 
are viewing a note, ManagePro displays a window where you can edit the note or one of the 
other text boxes.



File Utilities Transfer to/from diskette command
Lets you make a copy of your database to another location, typically a diskette, or back from
another location. Use this command to copy a single-user database to work on it away from 
the office, then to transfer it back when you are done.
This command has a dialog box. 



Transfer to/from diskette dialog box
See also Transfer to/from diskette command for overview and related topics.



Transfer to a diskette or a different path
Copies a database to a diskette or into a different path.



Transfer from a diskette or a different path
Copies a database from a diskette or from a different path.



Diskette/path
Enter the full drive and pathname where you want to transfer database information to or 
from.



File Utilities Archive command
Lets you create a backup copy of your database as it exists right now, then optionally enter 
a date before which all entries will be deleted. Using this command you can delete all entries
older than a specified date. 
This command has a dialog box. 



Archive dialog box
See also Archive command for overview and related topics.



Archive database without deleting old data
Archives a database without deleting old data.



Archive database deleting old data
Archives a database and deletes the old data.



Deletion date
Enter the date which ManagePro will use to determine what items in the database are 
deleted. For example, goals, to do items, and events with the due dates before this date will 
be deleted. ManagePro will also delete progress and feedback entries recorded before this 
date.



File Utilities Change file sharing type command
Lets you change the type of access other users have to your file. You normally specify this 
file type when you create a new file. You can change the type at any point in the future.
This command has a dialog box. 
_________
Related topics

Network access, setting up
Network, installing ManagePro on a



Change file sharing type dialog box
See also Change file sharing type command for overview and related topics.



No one will access this file
Prevents other users from accessing the data in this file.



People will have access to selected parts of this file
Gives other users access to selected data in this file.



People will have full access to this file
Gives other users access to all the data in this file.



View Goal Status Board command
Displays the status of your groups primary and supporting goals, with colored (or shaded) 
lights representing the current status of each goal. The current status is driven by the 
progress of goals assigned to various people and teams. 
A colored triangle appears just right of the Goal Status Board button in the View Bar if the 
status of one of your goals falls behind (yellow) or becomes critical (red).
In the Goal Status Board, you can:
· monitor the status of your primary business goals as driven by the progress of goals 

assigned to various people and teams
· obtain at-a-glance reinforcement of where you, as manager, need to focus your attention 

and intervene
· avoid over-managing those people and teams that are doing well on their own
· edit, copy, cut, paste and delete goals
· print the Goal Status Board in black and white or color
· zoom in or out to increase or decrease the size of goals
· move quickly right or left a screen full of status lights using the Tab or Shift-Tab keys
This command has a window
_________
Related topics

Goal Status Board, using
Goal View, changing



Goal Status Board window
See also View Goal Status Board command for overview and related topics.
Goal Status Lights

On the top row are your primary goals, as currently defined. Each goal is represented by a
colored status light. 
Green symbolizes that all supporting subgoals are not started, on track or done.
Yellow means that at least one subgoal is behind.
Red means that at least one subgoal has been designated as critical.
Note: If a subgoal or checkpoint has been set (using the Special button) in the Goal 

Details form to Ignore Roll-Up or if you have manually overridden a goal light, 
then rolled-up status lights do not reflect actual status.

Arrow buttons pointing downward indicate that there a subgoal supporting this goal. 
No Arrow buttons below lights indicate that this is a lowest-level goal, that is, there are 
no subordinate subgoals.
Red outline means this is the currently selected goal. ManagePro explodes the goal 
hierarchy one level below this goal, if one exists. By selecting lower-level goals, you can 
quickly peel the onion to see what may be driving a primary goal yellow or red (behind or 
critical).



View People Status Board command
Displays the status of current people or team performance relative to their goals, or people 
management activities. You can examine or be alerted to the status of each person or team.
A colored triangle appears just right of the People Status Board button in the View Bar if the 
status of one of your people management activities is approaching (yellow) or becomes 
overdue (red.)
In the People Status Board, you can:
· view an at-a-glance status of the current performance of people or teams relative to their 

goals in summary form
· view the execution status of people management activities that you have asked 

ManagePro to remind you to do
This command has a window
_________
Related topics

People Status Board, opening



People Status Board window
See also View People Status Board command for overview and related topics.
Goals

Double click on a Goals column item to display the Goal Status Board and access data 
related to goals. The color of a person or team's goals signify if the goal is Behind or 
Critical. 

Progress
Double click on a Progress column item to display the Status Board Explanation and 
access data related to progress. The color of a person or team's progress signifies how 
soon you should enter progress notes. 

Feedback
Double click on a Feedback column item to display the Status Board Explanation and 
access data related to feedback and coaching. The color of a person or team's feedback 
signifies how soon you should give feedback and coaching. 

Review
Double click on a Review column item to display the Status Board Explanation and access 
data related to reviews. The color of a person or team's review signifies how soon you 
should give performance appraisals or reviews. 

Recognition
Double click on a Recognition column item to display the Status Board Explanation and 
access data related to recognition. The color of a person or team's recognition signifies 
how soon you should give recognition. 

Commitments
Double click on a Commitments column item to display the Status Board Explanation and 
access data related to commitments. The color of a person or team's commitments 
signifies how soon you have a commitment due. 



View Assistant command
Displays the Assistant window so you can see important information in one place and focus 
on items that need attentions - like goals that are critical or overdue. The Assistant window 
collects data from each of ManagePro's three areas of focus - Goals, People and Actions - and
displays them in one window for quick review.
In the Assistant window, you can:
· display up to eleven different views of ManagePro data in at-a-glance format or full-screen
· view the status of activities that you have asked ManagePro to remind you to do
· view the status of critical goals in summary form
· view the status of your people and teams management tasks

modify the filters used to select which information is in the summary tables 
This command has a window
_________
Related topics

Assistant window, using



Assistant window
See also View Assistant for overview and related topics.
Summary tables 

Displays todays to do items, critical goals or upcoming people management tasks. If you 
have entered to do items for today, goals that are critical or people management tasks 
that are upcoming elsewhere in the database, they appear in the summary tables. 
Otherwise, the tables are empty.
You can double-click the Todays To Do Items, Critical Goals or Upcoming People 
Management Tasks text boxes in the summary tables to display the Details form for the 
selected item as described below. 
You can configure any of the 11 views that are available, three of which appear in the 
Assistant window by default. 
The default Assistant views (summary tables) are:
· Todays To Do Items
· Critical Goals
· Upcoming People Management Tasks

The other available Assistant views are:
· Action Items
· Goals Due Soon
· Goals Not Updated Recently
· Goals Updated Recently
· Other To Do Items
· Overdue Goals



· Upcoming Commitments
· Upcoming Events

Tool buttons 
Sort, filter, configure and print the summary table.

Related View buttons
Add details or notes for the selected row in one of the displayed summary tables. Each 
related view window is described later in this chapter.

_________
Related topics

Assistant window, using



Options Assistant command
Specifies how often ManagePro should display the Assistant window for you. You can 
configure the Assistant Window to open automatically once a day or whenever you open a 
database. 
Note: You can also add additional summary tables or modify the filters used to select which 

information is in the summary tables using the Configure Tool button or the Configure
Planner command from the Assistant menu when the Assistant is open.

This command has a dialog box.
_________
Related topics

Assistant window, using
View Assistant



Assistant Options dialog box
See also Options Assistant command for overview and related topics.



Never automatically open the Assistant
Prevents ManagePro from opening the Assistant window automatically. You must choose the 
View Assistant command or click on the Assistant button to open the window.



The first time a file is opened each day
Sets ManagePro to open the Assistant window whenever a file is opened for the first time in 
a given session of ManagePro.



Every time you open a file
Sets ManagePro to open the Assistant window every time you open a file.



Options Backup command
Specifies how often ManagePro should create a backup of your data and how many copies 
you would like. When you save a database, ManagePro asks if you would like it to perform 
the backup. It also lets you know whether other people are currently using the database. 
This command has a dialog box.



Backup Options dialog box
See also Options Backup command for overview and related topics.



How often
Enter in hours how often you want ManagePro to remind you to save the active database. 
Set the number in hours from zero. 
Example: 10
Type 0 hours to turn off this feature.



How many backups
Enter the number of copies you want to keep of the active database.
Example: 10
The backups are numbered with extensions 01D, 01X then 02D, 02X, etc. If you specify two 
copies, ManagePro alternates between the 01D/01X and the 02D/02X extensions. 
After you perform a File Save, ManagePro checks to see if it is time to create a backup. If it 
is, the program asks you whether or not you want to proceed.



Options Environment command
Sets preferences for how data is displayed, saved, networked and other miscellaneous 
options.
This command has a dialog box.
_________
Related topics

Environment options, setting



ManagePro Options dialog box
See also Options Environment command for overview and related topics.



Use Monochrome/LCD colors 
Displays ManagePro windows in black and white. When turned off, the ManagePro windows 
appear in color.



Open planners full screen size 
Maximizes ManagePro planners to full size of the workspace (below the ManagePro View and
Tool Bars). 



Save open windows and restore next time 
Specifies whether ManagePro remembers and restores the open windows (including their 
size and positioning) the next time you start the program.



Background save mins (single user):
Enter the number of minutes you want ManagePro to wait before it automatically saves your 
single user database in the background. Set the number in minutes from zero. 
Example: 10
Type 0 minutes to turn off this feature.



Save database before printing 
Automatically saves the database before printing a report to the printer.



Generate automatic progress entries 
Automatically creates a progress entry for you if you change the status of a goal.



Enter inserts blank lines 
Sets the Enter key to insert blank lines in a planner. When turned off, the Enter key moves 
the cursor to the next line without inserting a blank line. You can always press Shift-Enter to 
insert a new blank line.



Email options 
Select one of the following mail options:
No E-mail
Lotus cc:Mail 1.1
Microsoft Mail. 
Note: If you select Lotus cc:Mail, you also need to specify the location where your cc:Mail 

program is located on the hard drive. 



Always request password on maximize 
Requires the user to enter a password when they maximize the application.



Options Usage Style command
Sets the level of involvement you want to have with ManagePro and the number of features 
displayed. There are five different styles included in ManagePro that let you pick different 
levels of goal and people management functionality. 
This command has a dialog box.
_________
Related topics

Usage style, selecting



Setting Usage Style dialog box
See also Options Usage Style command for overview and related topics.



Usage Style 
Choose a usage style from the list.



Usage Style Description
Displays help information that describes the benefits of the usage style you choose in Usage
Style.



Set Style
Changes the level of involvement to the chosen usage style. Some features may no longer 
be displayed.



Options Terminology command
Adds, changes and deletes the names, colors and descriptions of options that can be 
entered in columns or text boxes in ManagePro.
This command has a dialog box.
_________
Related topics

Terminology of options, changing



Terminology Editor dialog box
See also Options Terminology command for overview and related topics.



Option Lists
Choose a title from the list that you want to modify or review.



Option List Description
Displays help information that describes the title you choose in Options Lists.



Option List Items
Displays the option items that are available for the title you selected in Option Lists.



Name 
Enter the name of a new option you want to add.



Light Color 
Choose a color to visually identify the status of goals in status boards. 



Description 
Define a brief description for the new option.



Up and Down buttons
Moves the highlighted item up or down in the option list.



Add
Adds the option you added in Option List Item Description to Option List Items.



Delete
Deletes the selected item in Option List Items.



Default
Makes the highlighted Option List Item the default item in this Option list. This is the item 
that will be automatically assigned to the new goals, to do items, etc. For example, you 
could change the default priority to 2 instead of 1 with this button.



Update
Updates the information you changed in Option List Item Description and adds the updated 
option to Option List Items.



Quick Input Event Scheduler command
Enter to do items, individual or recurring events, new goals, progress data, feedback and 
coaching, commitments or recognition from anywhere in ManagePro. ManagePro 
automatically stores the completed form in the correct part of the database, saving you 
time.
This command has a dialog box.
_________
Related topics

Events, entering



Event Scheduler dialog box
See also Quick Input Event Scheduler command for overview and related topics.
Title

Choose from the list of events or type the title of the event.
Type

Displays the event type or lets you choose an event type for the event in Title.
Scheduled Dates

Displays the dates for the event in Title.
Select

Choose an event date sorting criteria for the dates listed in Scheduled Dates. The default 
is None.
None Clears highlighted event dates. 
Single Highlights all the single date events.
Recurring Highlights all the recurring date events.
All Highlights all the single and recurring date events.

Edit
Displays the Event Description dialog box so you can change the date and event 
description.

Shift
Displays the Shift Events dialog box so you can specify how to change dates.

Delete
Deletes the highlighted event(s).

Single Date
Enter a single event date. Use with the Add Single button.

Add Single
Adds the single event date typed in Single Date.

Recurring
Opens the Set Recurring Event dialog box so you can set recurring event date ranges, 
intervals and specific dates. 
Example: If you want to have a staff meeting the 2nd Wednesday of each month, enter a 
starting and ending date range for the recurring event to be in effect. Then select an 
interval by entering a number in the text box (in this example, 1) and clicking the 
appropriate date value: Months. Select Wednesday to complete the recurring event.

OK
Saves the events.



Filter button
Sets conditional criteria for information you want to view.    Planner views let you save filters 
so you can easily reapply them later
This button has a dialog box.
_________
Related topics

Information, filtering



Planner Filter dialog box
See also Filter button for overview and related topics. 



Load
Choose a previously existing filter or create a new filter.



Set#1
Displays the Set Filter Criteria dialog box so you can define the first filter condition.



And Or
Choose "And" or "Or" to connect your first and second filter sets. 



Set #2
Displays the Set Filter Criteria dialog box so you can define the second filter condition.



And Or
Choose "And" or "Or" to connect your second and third filter sets.



Set#3
Displays the Set Filter Criteria dialog box so you can define the third filter condition.



And Or
Choose "And" or "Or" to connect your third and fourth filter sets.



Set #4
Displays the Set Filter Criteria dialog box so you can define the fourth filter condition.



Update
Saves changes to the filter in Load.



Save As
Saves a new filter or renames an existing filter.



Reset
Returns the specified filter to default conditions.



Planner Configure Timeline command
Lets you to configure the appearance of the Timeline window. You can change the start and 
end dates, line styles and line colors.
This command has a dialog box. 



Timeline Specifications dialog box
See also Planner Configure Timeline for overview and related topics.



Start Date
Enter the beginning date for the timeline.



End Date
Enter the ending date for the timeline.



Grid Lines
Select the time period you want to use the divide the timeline into smaller segments.



Line Style
Select the type of line you want to use to represent the current due date.



Markers
Select the type of marker you want to use to represent a milestone.



Show Original Due Date
Divides the timeline into two sections to show the current due date and the original due date
of the goal. Lets you select a line style, marker and colors for the section of the line which 
represents the original due date.
For example:
If start date < original due date < current due date:

The start date to original due date section of the timeline appears in blue (the default 
color)
The original due date to the current due date section appears in red (the default color).

If start date < current due date< original due date:
The start date to current due date section of the timeline appears in blue (the default 
color)
The current due date to the original due date section appears in red (the default color).



Line Style
Select the type of line you want to use to represent the goals' original due date.



Markers
Select the type of marker you want to use to represent the original milestone.



Foreground Color
Select the color you want to use for the current due date lines.



Background Color
Select the color you want to use for the timeline background.



Past Due Color
Select the color you want to use to show when a goal is overdue.



Early Completion
Select the color you want to use to show when a goal is completed before the due date.



Edit Documents command
Lets you to add, delete, or launch documents attached to the current item.
This command has a dialog box 



Attached Documents dialog box
See also Edit Documents for overview and related topics.



List of attached documents
Select the attached document you want to work with. Lists all the documents that are 
attached to this item.



Attach
Displays the Attach window where you can select a document in the same way that you 
select a file to open.



Delete
Deletes the attached document you selected in the List of Attached Documents. It does not 
delete the document from being stored on your hard disk or a diskette.



Edit desc.
Displays the Change Document window so you can enter a different location where the 
attached document is located.



Launch
Starts the application you selected in the List of Attached Documents as though you had 
double-clicked its icon from the desktop/Program Manager window. If no application is 
associated with a document, ManagePro displays a message to let you know that it cannot 
find the application that created the document. In this case, you can Minimize ManagePro 
and start the application by double-clicking its icon and then opening the attached 
document from within the application.



Command Menus
File Controls files in the open windows and current directory.
Edit Controls editing of objects.
View Opens a people, goal, action, list, calendar or report window.
Options Sets general preferences and database update frequency.
Quick Input Displays windows so you can enter information.
Window Specific Provides different views that relate to the active window.
Window Controls multiple document windows.
Help Provides access to Help topics.



File Commands
Controls the files in the current window and controls the transfer of information.
Open Opens existing ManagePro databases that you have previously saved.
New Creates and names a new ManagePro database.
Save Saves a database which you made changes to using the database name that 

appears in the title bar of the ManagePro window.
Save As Saves a database with a different name than the one displayed in the title bar.
Utilities

Extract for mobile computing Extracts a copy of the database.
Synchronize this mobile data with base Updates an extracted database.
Synchronize this file with mobile dataUpdates the database on the primary computer 

or network.
Transfer to/from Diskette Copies single-user ManagePro database files to 

and from diskettes.
Archive Creates an archive, or backup copy, of your 

ManagePro database files.
Export current window Exports the contents of the active window for use

with another application.
Export selected items Exports the currently selected items for use with 

another application.
Export entire database Exports your entire ManagePro database for 

upgrading to a new version of ManagePro.
Import into current window Brings information created in another application 

into the active ManagePro window.
Import entire database Automatically upgrades from one version of 

ManagePro to another.
File Information Displays the current location on the hard disk and

access level of the database.
Change file sharing type Modifies the file access for the database.
Refresh shared file Updates the information you see in the database 

when multiple people are making changes at the 
same time.

Printer Setup Specifies standard Microsoft Windows printer setup options such as the
type of printer you are using, paper size and orientation.

Print Print the contents of the active (or topmost) window.
Print selected items Prints the information that is currently selected.
Mail selected items Mails the information that is currently selected.
Exit Exits ManagePro application and goes to the Program Manager window.



Edit Commands
Modifies objects in the current window, adds notes to objects and searches for text in the 
database.
Undo Undoes the last action you performed; the last undoable action appears 

after the Undo command name.
List changes Lists recent changes that you can undo.
Cut Removes selected information, placing it on the Clipboard so you can 

paste it elsewhere.
Copy Places a copy of the selected information on the Clipboard so you can 

paste a copy of it elsewhere.
Copy Link Same as Copy but lets you specify which fields to place on the Clipboard.
Paste Places information from the Clipboard to the currently selected location. 

The contents of the Clipboard remain the same until the next time you cut 
or copy information.

Paste Link Pastes information from another Windows application into the selected 
ManagePro items and creates a permanent link to that information.

Insert Inserts one or more blank rows in a planner window.
Insert linked copy Creates a link to another goal in the Goal Planner windows. See I  nserting   

linked copies of Goals
Delete Deletes selected rows in a summary table.
Notes Attaches or edits a note on a selected object.
Documents Adds, deletes, or launches documents attached to the current item.
Search Searches for a word or phrase in the open database.



View Commands
Opens a people, goal, action list, calendar or reports window.
Goal Planner Displays a text window for adding to and working with your overall 

goals.
Goal Timeline Displays a timeline view of the Goal Planner information with timeline 

bars to show the duration of your goals.
Goal Status Board Displays a graphics window for managing goals.
People/Team Planner Displays a text window for adding to and working with people and 

team information.
People Status Board Displays the current status of individual goals and people management

activities.
To Do List Displays a list of to do items that lets you enter, delegate and track 

small detailed tasks often required to support goal and people 
management.

Action List Displays a list of action items (associated with ManagePro tracked 
goals and people management activities that optionally includes other 
items) and their current status.

Global Calendar Displays dates for goals, commitments, people management activities 
and action items. 

Assistant Displays ManagePros three areas of focus: goals, people, and actions 
information in a single place. 

Reports Planner Displays a window for selecting reports to print to the printer, to a file 
or to the screen from the people, goals or action item windows.

Network Messages Lists progress messages sent by team members. (appears if you are 
working with a networked database). See S  etting up Network access,  



Options Commands
Sets general preferences and database update frequency.
Environment Sets preferences for a variety of overall options for how you want the 

program to operate.
Display Specifies whether to display the View Bar, Message Bar, and Tool Bar 

and selects the location of the Tool Bar.
Assistant Specifies how often, if ever, you want ManagePro to open the Assistant 

window for you.
Network Specifies how often ManagePro should refresh information that has 

changed in a shared database and the common location for shared 
databases. See I  nstalling ManagePro on a Network  

Security Enters a master password to protect your databases (ManagePro 
databases are always encrypted for security.) .

Backup Selects how often, if ever, you want ManagePro to perform backups 
when you save and how many backup copies you want to keep.

Terminology Renames the standard lists of terms that come with ManagePro.
Usage Style Specifies a usage style that indicates the level of usage you prefer and 

which features are available.
Colors Selects the colors used for ManagePro windows and status lights.
Reminder Frequency Specifies how often ManagePro should remind you about various 

management activities based on your default reminder frequency. You 
can also select a different reminder frequency for a particular person or
team if you need to.



Quick Input Commands
Displays windows so you can enter to do items, individual or recurring events, new goals, 
progress data, feedback and coaching, commitments or recognition from anywhere in 
ManagePro. 
To Do Item Displays a new To Do Item Details window.
Event Displays a new Event Details window.
Scheduler Displays the Event Scheduler window.
Goal Displays a new Goals Details window.
Progress Data Displays a new Progress Data Details window.
Feedback/Coaching Data Displays a new Feedback/Coaching Details window.
Commitment Displays a new Commitment window.
Recognition Displays a new Recognition Details window.



Window-specific Commands
Provides different views that relate to the active window. The menu title changes to indicate 
the kind of commands it currently contains. This menu is context sensitive and offers 
commands that relate to the active window. The window-specific menu titles are:
Planner 

(available when the Goal Planner is active) lets you specify what information should be 
displayed on the planner, quickly expand or collapse the planner outline, selectively 
demote or promote an entry and sort/unsort the order of entries.
Lets you change the appearance of the timeline window with the Configure Timeline 
command.

People/Team  
(available when the People/Team Planner is active) lets you specify what information 
should be displayed on the planner, define a team, find, filter and sort.

Status Board 
(available when the Goal Status Board window is active) lets you choose to view the 
status board by Goal status, Goal priority, or Goal schedule status. It also allows you to 
show or hide items with their status marked Done, find, filter, sort or remove sorting.

Action 
(available when the Action List is active) lets you display a list of action items for goals, 
people management, to dos, commitments and events. You can select to display any 
combination of these action items in this window.

Calendar 
(available when a Calendar is active) lets you select specific dates, filter calendar entries 
based on the type of entry (such as goals, action items, people management activities, or 
commitments) or specific relationships (such as responsibility, status, priority, date and so
on) and switch to a year-, month- or week-at-a-glance view of the Calendar.

Assistant 
(available when the Assistant window is active) lets you zoom in or out on items and 
configure the Assistant views or view titles.

Reports 
(available when the Reports Planner is active) lets you send your report to the screen, 
printer or to a file. It lets you configure report options and copy all of a report to the 
Clipboard.

Form 
(available when any Details form is active) lets you save the current form as a template, 
copy a template, copy an object or configure the forms appearance.

Search 
(available after you perform a search by choosing Search from the Edit menu when the 
Search Results window is active) lets you find, filter, sort and remove a sort.



Window Commands
Provides different views that relate to the active window.
Cascade Resizes and layers the open windows in ManagePro so each title bar

is visible.
Tile Divides the screen space into smaller windows of similar sizes for 

each open ManagePro window.
Close all Closes all open ManagePro windows, leaving the main ManagePro 

window open.
Arrange Icons Rearranges any icons you have created using the Minimize 

command.
Numbered window names Switches from one open ManagePro window to another by 

choosing a window name.



Help Commands
Provides different views that relate to the active window.
Program help Gets context-sensitive help about the particular window you are 

using in ManagePro.
Help index Displays the Help Index so you can browse through program Help 

topics or quickly find the topic of interest.
Advisor help Gets context-sensitive management help about what you are working

with.
Advisor index Displays the Advisor Help Index so you can browse through Advisor 

Help topics or quickly find the topic you want to learn more about.
Tutorial Displays an index of the on-line tutorials that help you learn to use 

ManagePro.
About Shows the following information about ManagePro:    the version 

number, copyright information, your serial number, and Avantos 
support and fax phone numbers.



Step by Step Procedures Index
Planning your goals
Tracking your people and teams
Organizing yourself and your time
Printing your reports
Customizing ManagePro
Using ManagePro



Getting Started
It is a very good idea to start learning about the program with the interactive on-line tutorial.
The Guided Tour takes you through a sample database and shows you how to view and enter
information. It makes learning the program much faster and easier. Once you have taken the
tour, you can use the topics below to help you get started with your own ManagePro 
database.

Database, creating
Usage style, selecting
Primary Goals, adding
Goals, demoting
Goals, promoting
Goals, inserting linked copies of
People/Team Planner, adding people or teams in
Team members, defining
Progress data, entering
Feedback and coaching, planning
To Do list, using
To Do item, adding
Events, entering
Commitment, entering
Assistant window, using
Reports Planner, printing from
Help, getting



Planning your goals
Goal Details form, opening
Goal Planner, opening
Goal Planner, closing
Goal Status Board, using
Goal Timeline, using
Goals, demoting
Goals, promoting
Goals, expanding
Goals, collapsing
Goals, inserting linked copies of 
Goals, changing the view
Primary Goals, adding
Progress data, adding
Timeline Bar, changing
Timeline Bar, creating a new
Timeline Bar, changing the appearance of
Timeline Bar, configuring



Tracking your people and teams
Commitment, entering
Detail forms, opening
Feedback and coaching, planning
Feedback and coaching, recording
Feedback and coaching, reviewing
Formal review entries, creating
Interim review entries, adding
Notes, adding
People/Team Planner, adding people or teams in
People Status Board, opening
People/Team Progress data, adding
Progress data, entering
Reminder frequencies, setting
Team members, defining



Organizing yourself and your time
Action items, selecting for viewing
Action items, deleting
Action List window, opening
Action List window, closing
Assistant window, using
Calendar entries, selecting for viewing
Calendar entry, changing the date of
Calendar item, editing
Calendar item, deleting
Day view, selecting
Events, entering
Events, setting up recurring
Global Calendar, opening
Global Calendar, closing
Item Detail Form, opening
Month view, selecting
To Do item, adding
To Do list, using
Today's date, moving to
Week view, selecting
Week view, moving in
Year and month views, moving in
Year view, selecting



Customizing ManagePro
Environment options, setting
Field, changing the name of a
Field, inserting or adding new options for
Network access, setting up
Network, installing ManagePro on a
Security, setting
Status options, adding new with new colored lights for the status board
Terminology of options, changing



Using ManagePro
Active form, printing
Active planner, printing
Changes, undoing
Column widths, adjusting
Columns, inserting
Columns, removing
Database, backing up
Database, saving
Database, copying to and from a diskette
Database, opening
Database, searching
Extracted database, synchronizing with the base database or vice versa
Form, saving as a template
Information, moving, copying and deleting
Information, sorting
Information, filtering
Information, finding in the active window
Information, copying between forms
Report Planner, printing
Rows, deleting
Rows, inserting
Selected items, printing
Shared database, creating
Template, copying into an open Details form



Troubleshooting
Contacting Avantos
Gathering what you need before you contact us
Solving problems in ManagePro



New Features
Ease of use and interface enhancements

Assistant window
Assigning more than one person to a goal, progress, to do item, etc.
Moveable Tool Bar
Message Bar
Right mouse click menu

ManagePro as a "Home Base"
To Do list and Goal To Do list
Day at a glance and week and day printouts
Linking with other applications - DDE
Linking with other applications - document attachment
Direct E-Mail support

Multi-user support
Simultaneous multi-user access
Mobile computing support
Cross-platform support



Special topics
Dates, entering
Goal Status field, customizing
Keyboard shortcuts, using
Mobile computing support, using
Roll-ups, controlling



Printing your reports
Active form, printing
Active planner, printing
Reports Planner, printing from
Reports Planner, opening
Reports Planner, closing
Selected items, printing



To create a database
Use this procedure to create a new database.
1. Choose File - New.

The program displays the File New dialog box.
2. Type a name for the database.
3. Choose path (drive and directories) where the database should be stored, if necessary.
4. Choose OK.

Note: The first eight characters of the filename you enter are used as part of the 
filenames for various database files that ManagePro creates. Therefore, you 
should use letters or numbers and avoid using special symbols, punctuation or 
spaces for the first eight characters of a database filename.

_________
Related topics

Troubleshooting



To take the Guided Tour
Use this procedure to take the Guided tour.
1. Choose Help - Tutorial.
2. Choose the Guided tour with Sample Database option.
3. Choose Begin.

The Guided tour is an interactive tutorial that will take about a half an hour.



To select a Usage style
Use this procedure to increase or limit the ManagePro functionality. The more usage you 
choose the more powerful the benefits.
1. Choose Options - Usage style.
2. Choose one of the five usage styles listed in the Setting Usage Style dialog box..
3. Choose Set Style.

ManagePro will adjust the functionality automatically displayed based on the usage style 
you choose. The default is to show all functionality.

_________
Related topics

Options Usage Style command



To get help
Use this procedure to get help about the ManagePro program.
To get context-sensitive program or Advisor help:
1. Open the window of interest.
2. Choose Help - Program Help, press F1,

 - or - 
Choose Help - Advisor Help, press Shift-F1.
ManagePro displays the related help section, or if there isnt one, it displays the 
ManagePro Help or Management Advisor table of contents window.

To browse through the Program Help Index:
1. Choose Help - Help index.

ManagePro displays the ManagePro Help table of contents window.
2. Choose a topic of interest.
To browse through the Advisor Help Index:
1. Choose Help - Advisor index.

ManagePro displays the Management Advisor table of contents window.
2. Choose a chapter title and the section titles change to show you the topics available for 

that chapter.
3. Double-click a section title to view that topic.
To examine or begin one of the on-line tutorials:
1. Choose Help - Tutorial.

A list of the available tutorials appears.
2. Choose a tutorial name from the list and choose Begin.

A list of topics for the tutorial appear.
3. Choose Begin to start with the first topic in the tutorial

 -or- 
Choose a different topic and choose Begin (you can also double-click any topic to open 
it.)



To open a Goal Planner
Use this procedure to open the Goal Planner.
To open the top level goal planner
l Click on the Goal Planner button.

The Goal Planner window appears displaying the top-level planner where you can add or 
edit your overall, or top-level, goal information.
If you have entered goals anywhere in the database, the goals appear in this window. 
Otherwise, the Goal Planner window is empty and a cursor appears in the first row of the 
Goal Title column indicating that the next characters you type will appear in this text 
box.

To open the goal planner from a person or team goal view
l Click on the Goals Related View button in the People/Team Planner window.

The goal planner window appears displaying only the goals for the selected person or 
team.



To close a Goal Planner
Use this procedure to close the Goal Planner.
l Click on the Exit Tool button.



To add primary goals
Use this procedure to add a primary goal in the Goal Planner window.
1. Click on the Goal Planner button in the View Bar to open the Goal Planner.

ManagePro displays the Goal Planner window.
2. Move the cursor from one text box to the next by clicking the text box

 - or - 
Press Tab to move from left to right then down.
Note: You can press Shift-Tab to move from right to left.

3. Move to a row with a blank title to insert a new blank row
 - or - 
Choose Edit - Insert.

4. Type a goal title.
5. To choose the name of the person or team who is responsible for the goal and goal 

status:
Double-clicking the corresponding text box
 - or -
Choose the text box and press the ? key
 - or - 
Type the name of the person or team and goal status.
Note: The default status is Not Started. If you are viewing the priority, its default setting

is 1 (highest).



To demote goals
Use this procedure to push a goal one level to the right and it becomes a subgoal, push it 
right once more and it becomes a sub-subgoal and so on. ManagePro assumes that indented
goals are subgoals that support a less indented goal above. 
l Click on the right-pointing Demote Tool button

 - Or - 
Choose Planner - Demote.
The program pushes the goal right one level, demoting it.
Note You can select multiple goals by holding down the Shift key while clicking the 

mouse or while pressing the Up and Down Arrows and demote all the goals at 
once.



To promote goals
Use this procedure to push each goal left, thus defining the goals place in the hierarchy. The 
leftmost goals are primary goals. ManagePro assumes that indented goals are subgoals that 
support a less indented goal above. 
l Click on the left-pointing Promote Tool button

 - or - 
Choose Planner - Promote.
The program pushes the goal left one level, promoting it.
Note You can select multiple goals by holding down the Shift key while clicking the 

mouse or while pressing the Up and Down Arrows and promote all the goals at 
once.



To expand goals
Use this procedure to expand all goals below a selected goal when you want to view the 
detail subgoals.
To expand a single goal:
l Click on the Expand button at the left of any goal to show that goals subgoals

 - or - 
Press Ctrl-keypad + (plus).

To expand all goals:
l Choose Planner - Expand All.

 - or - 
Press Ctrl-e.

To expand goals to a selected level
l Choose a level number (from 1 through 9, with 1 being the highest level and 9 the 

lowest) from Planner - Expand To Level.
 - or - 
Press Ctrl-1, Ctrl-2,...Ctrl-9.



To collapse goals
Use this procedure to hide all goals below a selected goal when you want to focus on 
primary (or higher level) goals.
To collapse a single goal
l Click on the Collapse button at the left of any goal to hide that goals subgoals

 - or - 
Press Ctrl-keypad - (minus).

To collapse all goals
l Choose Planner - Collapse All.

 - or - 
Press Ctrl-c.



To insert linked copies of goals
Use this procedure to link goals into multiple locations in a goal planner or to link an 
individual's goal into the top level goal planner. For example, if "Market Research" impacts 
both "Develop launch plan" and "Analyze competitor strengths", then you could insert a 
linked copy of "Market Research" below "Analyze competitor strengths":

Develop launch plan
Market Research
Advertising analysis

Analyze competitor strengths
Product comparison study
Market Research (linked copy created with Insert Linked Copy)

1. Position the cursor where you want to insert a linked goal.
2. Choose Edit - Insert Linked Copy.

The program displays the Select Item(s) To Link window.
3. Choose one or more goals to be inserted as linked goals.

Each time you click a goal, you toggle between selecting or deselecting it.
4. Choose Link.

Note: If the goals you selected in the Select Item(s) To Link window already have a 
parent (or higher level) goal, the program inserts duplicate copies of the linked 
goals beneath the new parent goal. Linked goals appear in gray and when you 
change one linked goal, they stay "in sync" and are all changed as though they 
were a single goal.



To add goal progress data
Use this procedure to add new goal progress information in the Progress Data window.
1. Click on the Add button in the Progress Data window

 - or - 
Choose Edit - Add.

2. Type the progress data for this goal in the form.
Related Goal contains a list of all goals in the database. You must select a related goal.
Date is required; the value defaults to todays date. To change the date, you can edit the 
text in the MM/DD/YY format or type the appropriate offset (such as -2d or -3w). You can 
also access ManagePros calendar by double-clicking the date.
Comment The Comments text box lets you enter your comments about progress. You can
leave this text box empty.
Status shows current status of the related goal. You can update the status as you enter 
new progress data. Not Started, On Track and Done cause the appropriate status board 
lights to turn green. Behind causes the appropriate status board lights to turn yellow. 
Critical causes the appropriate status board lights to turn red.
Priority shows the current priority of the related goal. You can update the priority as you 
enter progress data.
Due Date shows current due date of related goal. You can update this as a result of the 
new goal progress data.

3. Choose OK.



To open a Goal Details form
Use this procedure to open a Goal Details forms to add, edit, or delete information about the 
goal including checkpoints, progress, status conditions, and goal measurements.
1. Double-click the goal title.

 - or 
Choose the goal whose details you want to view and click on the Details Related View 
button.

2. Type in the goal details.
Title defaults to the title you entered in the Goal Planner window, if any. Entering a goal 
title is mandatory.
Type is used for sorting purposes only. Result indicates a business-related objective. 
Skill/Mode indicates an individual or team developmental objective.
Short description is an optional, abbreviated title used for display on the Goal Status 
Board.
Long description is a text area where you can enter as long a description as needed for 
the goal. 
Who is the person or team directly responsible for the successful achievement of this 
goal.
Start date is the start date for the goal.
Due date is the date this goal must be completed. 
Priority is used for sorting and display purposes. Under ManagePros default 
configuration, 1=high priority, 2=medium priority and 3=low priority.
Status Status is the current subjective status of this goal (On Track, Not Started, Behind, 
Critical, or Done.) 

3. To access more details, click on the following buttons:
Checkpoints 
Measurement 
Progress 
Rollups 

4. Choose OK.



Checkpoints
The Checkpoints button displays the Checkpoint Scheduler window where you can set up 
multiple checkpoints for a goal including single or recurring checkpoints. These checkpoints 
appear in the Action List and Calendar as reminders to check on the status of this goal. You 
can enter a date in the usual fashion followed by a time.
After setting up a checkpoint, you can edit or delete it in the Checkpoints window. Entering 
checkpoints works just like entering an event using the Event Scheduler command from the 
Quick Input menu.



Measurement
The Measurement button displays the Measurement window where you can enter text 
descriptions for:

l The Measurement Basis is a text description indicating how success will be measured 
for this goal (for example, the number of widgets sold or sales force consensus.) This 
is highly recommended information to track and is often supplemented by a 
measurement scale that defines different levels of success.

l The Performance Versus Expectations text boxes are a five-level description (text or 
numeric) that defines various levels of potential performance for this goal.



Progress
The Progress button displays the Progress Data window for this goal. This is the same 
window that opens when you click the Progress Related View button from the goal planner.



Rollups
The Rollups button displays the Goal Rollups window where you can specify status 
conditions.
In the Goal Rollups window, you can tell ManagePro to:

l ignore this goal when the status of higher-level goals are calculated, or,
l manually set the status of this goal independent of the status of any lower-level goals

or checkpoints.
When you use either of these features, the true rolled-up status of high-level goals is shown 
as a colored stripe in the normal colored status light in the Goal Status Board.



To use a Goal Timeline
Use this procedure to graphically display the start and due dates for goals in the top-level 
planner.
l Click on the Goal Timeline button.

The Goal Timeline window appears displaying the top-level planner with horizontal bars 
showing the duration of each goal.

Also see
Progress data, adding
Goals, collapsing
Notes, creating
Goals, demoting
Goals, expanding
Goals, inserting linked copies of 
Goals, promoting



To change a Timeline Bar
Use this procedure to change start or due dates by dragging a goals timeline bar left or 
right.
To graphically change a start or due date:
1. Click on the Goal Timeline button.

The Goal Timeline window appears displaying the top-level planner with horizontal bars 
showing the duration of each goal.

2. Position the pointer above the left (start date) or right (due date) edge of a timeline bar.
The pointer changes to a double-tipped arrow with a box in the center.

3. Drag the timeline bar left or right and release the mouse button when the Start or End 
date that appears while you drag the bar reaches the date that you want.
 - or - 
Hold down the mouse button and press the Left or Right Arrow keys to adjust the 
timeline bar one day at a time.

To move a goal along the timeline without changing its duration:
1. Click on the Goal Timeline button.

The Goal Timeline window appears displaying the top-level planner with horizontal bars 
showing the duration of each goal.

2. Position the pointer in the middle of the timeline bar.
The pointer changes to a double-tipped arrow with a box in the center.

3. Drag the timeline bar left or right and release the mouse button when the Start or End 
date that appears reaches the date that you want.



To create a new Timeline Bar
Use this procedure to create a new Timeline bar.
1. Click on the Goal Timeline button.

The Goal Timeline window appears displaying the top-level planner with horizontal bars 
showing the duration of each goal.

2. Position the cursor at the start date.
3. Drag to the right to create a new timeline bar.



To change the appearance of a Timeline Bar
Use this procedure to use Tool buttons to change the starting date and time periods 
displayed on the Timeline bar.
Changing the starting date to today
l Click on the Today Tool button

 - or - 
Choose Planner - Configure Timeline.

Zooming in or out on the timescale
l Click on the Zoom In Tool button to change the timescale to shorter time periods. 

- or -
Click the Zoom Out Tool button to change the timescale to longer time periods.



To configure a Timeline Bar
Use this procedure to    configure the appearance of the Timeline window. You can specify the
Start Date, End Date, Foreground Color, Background Color, Line Style, Grid Lines and 
Markers.
1. Choose Planner - Configure Planner.

The Planner Configuration window appears.
2. Click on Timeline.
2. Enter an optional Start or End Date using one of the ManagePro date formats (such as 

entering 5/12/92, next tues, March 10 and so on.) 
3. Choose from the following options:

Foreground Color
Background Color
Line Style
Grid Lines
Marker

4. Click OK.



To use the Goal Status Board
Use this procedure to use the Goal Status Board, the primary tool for monitoring the status 
of your primary business goals, as driven by the progress of goals assigned to various 
people and teams.
1. Click on the Goal Status Board button.

The text below each status light shows:
Title or Short Description of this goal.
Person or team assigned to this goal.
Due date of this goal. 
Note: The full goal title for the selected goal can be found at the top of the Goal Status 

Board.
2. To view the primary goals that cannot fit in the window:

1. Maximize the window.
2. Use the cursor keys to move to the right.

- or -
Click the right arrow button.
- or -
Use the Find Tool button.

Each goal's colored lights mean:
Green symbolizes that all supporting subgoals are "not started," "on track" or "done".
Yellow means that at least one subgoal is "behind".
Red means at least one goal is "critical".
Note: If a subgoal or checkpoint has been set (using the Special button) in the Goal 

Details form to Ignore Roll-Up or if you have manually overridden a goal light, 
then rolled-up status lights do not reflect actual status. 

3. Click on a goal to view each goals subgoals, if any.
Arrow buttons pointing downward indicate that there a subgoal supporting this goal.
Lights with no Arrow buttons below them pointing downward indicate that this is a 
lowest-level goal, that is, there are no subordinate subgoals.

4. Double-click a light of interest to display a Status List - a list of all subgoals supporting 
this goal, sorted by current status.

5. To highlight a subgoal:
1. Use your arrow keys

 - or - 
Use the mouse .

2. Click the Find Tool button to instantaneously position the status board and cursor on
that subgoal.

_________
Related topics

Goal Status Board command



To change the goal view
Use this procedure to change the Goal Status Board to display colored lights based on 
status, priority, or schedule status.
1. To view the Goal Status Board by:

l Status, choose View as - Goal status.
l Priority, choose View as - Goal priority.
l Schedule, choose View as - Goal schedule status.

2. Choose Options - Reminder frequency to specify how much advanced notice you want 
that a goal is approaching its due date.



To add people or teams in a People/Team Planner
Use this procedure to add a person, or a team and its people that you work with or supervise
to the People/Team Planner.
1. Click on the People/Team Planner button.

Note: If you have entered people or teams anywhere in the database, an entry appears 
for them in this windows summary table. Otherwise, the People/Team Planner 
window is empty and a cursor appears in the first row of the Name column 
indicating that the next characters you type will appear in this text box.

2. Choose the row where you want the person to be placed and choose Edit - Insert.
3. Type the data for this person/team in the form.

Name Type a name for the person or team in any format. If you plan to sort people and 
teams by name, you may want to enter the persons last name first.
Reminders? Change No to Yes if you want ManagePro to prompt you periodically to 
review the progress of your peoples goals and to communicate feedback and recognition 
to them. You can set the frequency of the reminders overall using Options - Reminder 
Frequency.
Alphanumeric characters. You can use any kind of separator character such as 
parentheses, hyphens or periods.

4. Choose OK.



To define team members
Use this procedure to add the individual team members to the summary table and then 
define these people as members of that team. You can enter goals, performance data, 
feedback/coaching, reviews and so on for a team. Progress data, feedback/coaching and 
reviews are automatically copied to each team member when you enter this information for 
the team.
1. Be sure you have first added each of the team members to the People/Team Planner as 

well as the team to be defined.
2. Choose the name of the team.
3. Click on the Team button.

If you have previously defined a team, its existing members are highlighted.
4. Choose each individual that should be a member of this team.

 - or - 
Choose a highlighted name to remove it from the team
 - or - 
Choose Clear to remove all members from the team so you can select an entire new 
group of members.

5. Click OK.



To add goal progress data for people/teams
Use this procedure to add new goal progress information for this person or team.
1. Click on the Progress button.
2. Click on the Add button in the Progress Data window

 - or - 
Choose Edit - Add.

3. Type the progress data for this person in the form.
Name is required; the value defaults to the person or team chosen when you opened this 
form. Choose from the drop-down list box to choose a different name.
Date is required; the value defaults to todays date. To change the date, you can edit the 
text in the MM/DD/YY format or type the appropriate offset (such as -2d or -3w). You can 
also access ManagePros calendar by double-clicking the date.
Comment The Comments text box lets you enter your comments about progress. You can
leave this text box empty.
Related Goal contains a list of all goals in the database. You must select a related goal.
Status shows current status of the related goal. You can update the status as you enter 
new progress data. Not Started, On Track and Done cause the appropriate status board 
lights to turn green. Behind causes the appropriate status board lights to turn yellow. 
Critical causes the appropriate status board lights to turn red.
Priority shows the current priority of the related goal. You can update the priority as you 
enter progress data.
Due Date shows current due date of related goal. You can update this as a result of the 
new goal progress data.

3. Click on the Goal Details button to view a related goal's Details form.
4. Double-click the progress note entry to view previous progress notes.
5. Choose OK.



To plan feedback and coaching
You can enter specific feedback or coaching notes for a person or team using the Quick Input
Feadback/Coaching command, or you can use this procedure:
1. Open the People/Team Planner window.
2. Select the person or team for which you want to make an entry.
3. Click on the Progress Related View button.
4. Click on the Plan Feed Related View button in the Feedback/Coaching window.

To help you plan feedback and coaching, the program generates a Progress Data report.
Note: ManagePro displays the Plan Feedback/Coaching Details form.

5. Type the feedback or coaching data for this person in the form.
Who is required; displays the name of the currently selected person or team.
Recent Performance Data is a read-only display of performance data that you have 
previously entered for this individual or team. 
Comment Plan The Comment text box lets you make feedback and coaching notes to 
yourself for use in later communications.
Coaching Topics ask ManagePros Advisor for advice that helps you diagnose 
performance or behavioral issues and develop appropriate coaching advice.

6. Choose OK.



To record feedback and coaching
Use this procedure to record notes about a person or team feedback or coaching.
1. Click on the Add Related View button in the Feedback/Coaching window

 - or - 
Choose Edit - Add.

2. Type the notes about a person or team feedback or coaching.
Name is required; displays the name of the currently selected person or team.
Date is required; the value defaults to todays date. To change the date, you can edit the 
text in the MM/DD/YY format or enter the appropriate offset from today (such as -2d; -3w;
end of last week). You can also access ManagePros calendar by double-clicking the date.
Comment The Comment text box lets you record key feedback and coaching messages 
that you have delivered.
Coaching Topics provides topics to which you can link this feedback and coaching. 
Related Goals lets you create an optional link to an existing goal. Select a related goal if 
you want to be able to view feedback and coaching sorted by goals.

3. Choose OK.



To review feedback and coaching
Use this procedure to view    feedback and coaching details.
1. View details for an existing feedback and coaching entry in one of three ways:

l Click on the Details Related View button while the entry whose details you want to 
view is selected.

l Double-click the feedback/coaching entry whose details you want to view.
l Press Ctrl-L while the entry whose details you want to view is selected.



To add interim review entries
Use this procedure to capture interim review notes. If you prefer reviewing this person or 
team at year-end, see Adding a formal review entry.
1. Click on the Interim Related View button in the Reviews window.

ManagePro asks if you want to view historical data.
1. Choose Yes.

Note: ManagePro opens the Report Planner and displays the Output Specifications 
window so you can give the report a name and decide whether to send your 
historical report to the screen, printer or a file.

 - or    - 
2. Choose No. 
Note: When the report finishes or if you clicked No, ManagePro displays the Interim 

Summary Review window.
2. Enter the interim review information for this person in this form

Name is required; displays the name of the currently selected person or team.
Review Date is required; the value defaults to todays date. To change the date, you can 
edit the text in the MM/DD/YY format or enter the appropriate offset from today (such as -
2d; -3w; end of last week). You can also access ManagePros calendar by double-clicking 
the date.
Overall Message is the most important message that you want to convey during this 
interim review.
Important Messages contains text messages, supporting data and implications directly 
in the rows and columns of the Important Messages table. Or, you can double-click a line 
(or select it and press Ctrl-Enter) and ManagePro displays the Interim Review Message 
form where you can view more text at a time as you enter it.. 

4. Choose OK.



To create formal review entries
Use this procedure to create an entry for a person or team's formal or annual review..
1. Click on the Formal Related View button in the Reviews window.

ManagePro asks if you want to view historical data.
1. Choose Yes.

Note: ManagePro opens the ManagePro opens the Report Planner and displays the 
Output Specifications window so you can give the report a name and decide 
whether to send your historical report to the screen, printer or a file.

 - or    - 
2. Choose No. 
Note: When the report finishes or if you clicked No, ManagePro displays the Interim 

Summary Review window.
2. Enter the formal review information for this person in this form.

Who is required; displays the name of the currently selected person or team.
Review Date is required; the value defaults to todays date. To change the date, you can 
edit the text in the MM/DD/YY format or enter the appropriate offset from today (such as -
2d; -3w; end of last week). You can also access ManagePros calendar by double-clicking 
the date.
Complete? Choose Yes or No to indicate whether this formal review has been completed.
Reviewed Goals is the information for a goal that affects this review directly in the 
Reviewed Goals chart or double-click a line (or select a line and press Ctrl-Enter) to 
display the Goal Review Item form. In this form, you can enter a Title, Summary 
Comment, Rating (Far Exceeds, Exceeds, Meets, Meets Minimum or Unsatisfactory) and 
Weighting.
Summary Text Enter your review summary in this scrolling text box.
Rating lets you select an overall performance rating for this interim or annual appraisal:   
Far Exceeds, Exceeds, Meets, Meets Minimum or Unsatisfactory. 
Development Issues lets you select an overall performance rating for this interim or 
annual appraisal:    Far Exceeds, Exceeds, Meets, Meets Minimum or Unsatisfactory. 

3. Choose OK.



To open a People/Team Details form
Use this procedure to open a People/Team Details form to add, edit, or delete information.
1. Choose the person or team whose detail form you want to review.
1. Click on the Details Related View button
2. Type in or choose the People/Team details.

Name Type a name for the person or team in any format. If you plan to sort people and 
teams by name, you may want to enter the persons last name first.
Relationship Double-click inside the text box to display the relationship text box so you 
can choose a relationship. 
Phone Type a a work phone or extension for this person or team using any combination 
of alphanumeric characters. You can use any kind of separator character such as 
parentheses, hyphens or periods.

3. To access more details, choose the following buttons:
Job Data 
Reminder Freq 
Personal data 
Network access 

4. Choose OK.



Job Data
The Job Information window contains key information about the job position that this person 
or team holds.



Reminder frequency
Reminder Frequency determines how often you want ManagePro to remind you to track 
performance, give feedback/coaching, give interim performance appraisals and so on. A 
default reminder frequency is provided. You only need to use this form if you want to change
the default setting.
The reminder frequency you select for this person or team is representative of the tightness 
with which that person or team needs to be managed, based on their desire and ability to 
succeed on their own.



Personal data
Personal Data contains useful personal data about an individual such as home address, 
home and office phone numbers, education and so on.



Network access
Network Access lets you specify network access information for the selected person or team.
You can enter a password and select access to top level goals and the persons own goals. 
The levels of access to goals are:    No Access, Read Only, Post Progress Notes, Direct Modify 
and Full Add/Change/Delete.
ManagePro also lets you decide whether the person or team should have Read Only or No 
Access to:

l Progress Data
l Feedback/Coaching Data
l Reviews Data
l Development Plan Data
l Commitments Data
l Reports Planner
l Quick Input Menu
l Global Calendar



To open a People Status Board
Use this procedure to open the People Status Board, the primary tool for monitoring the 
status of individual's and team's goals, in summary form and the status of the people 
management activities that you asked ManagePro to remind you to do.
1. Click on the People Status Board button.
2. View each column's colored lights to receive a visual cue about its status:

Green Yellow Red
Goals On track/Done Worst=Behind Worst=Critical
Others No people mgt due People mgt soon People mgt overdue

3. Choose a column item to see its details:
Goals displays a person or team/s goals in the Goal Status Board window. Each goal 
displays a small light indicating its status. Double-clicking a goal light lets you review the 
goal details or progress data. 
Progress displays the Progress Status Board Explanation window helps you do this by 
explaining why a Progress light is yellow or red based on your reminder frequency setting 
and the elapsed time since the last progress notes you entered.
Feedback displays the Feedback Status Board Explanation window helps you do this by 
explaining why a Feedback/Coaching light is yellow or red based on your reminder 
frequency settings and the elapsed time since feedback and coaching was last entered.
Review gives you an explanation of why a Reviews light is yellow or red based on the 
reminder frequency setting and the elapsed time since a interim or formal review entry 
was last made.
Recognize displays the Recognize Status Board Explanation window gives you an 
explanation of why a Recognition light is yellow or red based on your reminder frequency 
setting and the elapsed time since a recognition entry was last made.
Commitments explains why a Commitments light is yellow or red in terms of the due 
date. It also displays all up-coming commitments you have made to this person or team.

_________
Related topics

People Status Board command



To set reminder frequencies
Use this procedure to specify a global reminder frequency that becomes the default settings 
applied to people and teams. You can override these settings by specifying individual 
reminder frequency settings for particular people or teams.
To specify the global reminder frequency
1. Choose Options - Reminder Frequency.
2. Enter frequency in the n days (or weeks or months) format.

Note: Advanced notice makes these people management activities turn yellow in the 
specified time period prior to due date. The input format is the same as for 
frequency.

To set the individual reminder frequency for a person or team:
1. Choose a person or team in the People/Team Planner window.
2. Click on the Details button to open the Details window.
3. Click on the Reminder Frequency button to open the individual Reminder Frequency 

window.



To enter progress data
You can enter progress data for an individual or team using the Quick Input Progress Data 
command, or you can use this procedure:
1. Open the People/Team Planner window.
2. Select the person or team for which you want to make an entry.
3. Click on the Progress Related View button.
4. Click on the Add button in the Progress Data window.

- or -
Choose Edit - Add 
- or -
Press Alt-E-A.

5. Enter the progress data for this goal in the form.
6. Choose OK.



To enter commitments
Use this procedure to add commitments in the Commitment form while the Action List 
window is active.
1 Click on the Commitment Related View button.

The Commitment form appears.
2 Enter or select the appropriate information.

Title Enter a title that briefly describes this commitment.
Who Select the person or team that you have made this commitment to by clicking the 
down arrow beside the Who drop-down list box.
Long Description optionally enter a long description about this commitment. 
Due Date is required; the value defaults to todays date. To change the date, you can 
edit the text in the MM/DD/YY format or enter the appropriate offset (such as -2d or -
3w). You can also access ManagePros calendar by double-clicking the date.
Priority shows the current priority of the commitment.
Status Select the status for this commitment:    To Do, On Hold or Done. If the status is 
set to On Hold or Done, the commitment causes the Commitment light on the People 
Status Board to turn green. To Do causes ManagePro to compare the due date to todays 
date and change the Commitment light to yellow or red based on the reminder frequency
you have set for your commitments.

3. Choose OK.



To add a note
Use this procedure to add notes.
1. Click on the Notes Tool button

The Notes window appears.
2. Type notes about the selected goal, person/team, or To do item.
3. Click on the Print Tool button to print the note.
4. Choose OK to save the note.



To open an Action List window
Use this procedure to open the Action List window.
To open the Action List window
l Choose the Tool button on the View Bar at the top of the ManagePro window.

The summary table displays a list of action items.



To close an Action List window
Use this procedure to close the Action List window.
l Close Tool button at the top of the Action List window.



To select action items for viewing
Use this procedure to select any combination of the Display check boxes to inclusively show 
the action items you are interested in.
l Choose the check box beside each action item type to toggle between selecting and 

deselecting it.
 - or - 
Choose Action - Show <action item type>.
Note: You can also choose Action - Hide Done Items to show or hide items whose Status 

is set to Done.



To delete action items
Use this procedure to delete action items.
1. Choose the event or To do item you want to delete.
2. Choose Edit - Delete

Note: Deleting a goal on the Action List deletes it everywhere including the top level 
and the responsible persons Goal Planner. If you would like to retain a record of 
the goal or commitment, set its status to Done and choose Hide Done Items from 
the Action menu to hide it in the Action List.



To add To Do items
You can add a to do item with the Quick Input - To Do Item command, in the To Do list, or 
from the Action list. Use this procedure to add a to do item in the Action list.
1. Click on the To Do Related View button.

The To Do Item Details form appears.
2. Type    the appropriate information.

Title Type a title that briefly describes this to do item.
Date/Time is required; the value defaults to todays date and time. To change the date 
and time, you can edit the text in the MM/DD/YY HH:MM format or enter the appropriate 
offset (such as -2d or -3w). You can also access a pop-up date picker by double-clicking 
the date. You can enter a time immediately following the date, for example:
5/15 4:30pm
Priority show the current priority of the to do item.
Status shows the status for this to do item: To Do, On Hold or Done.
Long description optionally enter a long description about this to do item.

3. Choose OK.
_________
Related topics

To Do list, using



To open an Item Detail Form
Use this procedure to select an item and open the related Details form to add detail 
information.
1. Choose the item whose detail form you want to view.

Note: Choosing Details for a people management reminder opens a window with an 
appropriate people management data Details form. For example, choosing Details
while Mark: Input Progress Data is selected opens a new Progress Data Details 
form for Mark.

2. Click on the Details Related View button
- or -
Double-click an Item Title in the Action List window as a shortcut to steps 1 and 2.
The appropriate Details form appears.

3. Enter or change information in this form.
4. Choose OK.



To open a Global Calendar
Use this procedure to open the Global calendar.
l Click on the Calendar button on the View Bar at the top of the ManagePro window.

The Global Calendar appears in the view that you last selected - Year, Month or Week.
Note: The personal Calendar available for a selected person or team in the People/Team 

Planner window by clicking the Calendar Related View button works just like the 
global Calendar. However, it displays information related to the selected person or
team rather than across-the-board planning information.



To close a Global Calendar
Use this procedure to close the calendar.
l Click on the Close Tool button at the top of the window.



To select Calendar entries for viewing
Use this procedure to choose any combination of the Display check boxes to exclusively 
show the calendar entries you are interested in.
l Click on the check box of each calendar entry type to toggle between selecting and 

deselecting it.
 - or - 
Choose Calendar - Show.



To select a year view
Use this procedure to change to the year calendar view.
l Click on the Yr Tool button

 - or - 
Choose Calendar - Year View.
Note: The Year view (the default view of any calendar) shows you eight months at-a-

glance. Each day that has calendar entries associated with it is highlighted with a 
solid gray box and white text. The selected date is highlighted with a red solid box
and white text. The box is black on monochrome/LCD screens.



To select a month view
Use this procedure to the month calendar view.
l Click on the Mo Tool button.

 - or - 
Choose Calendar - Month View
 - or - 
Double-click inside the Year view to instantly zoom in to the Month view.
Note: The Month view shows you a month at-a-glance. Each day box that has calendar 

entries associated with it contains an X through it. The selected date is 
highlighted with a red or black border around the day box. The number of entries 
in each day appears in parentheses after the X.



To select a week view
Use this procedure to show a week at-a-glance calendar view.
l Click on the Wk Tool button.

 - or - 
Choose Calendar - Week View
 - or - 
Double-click inside the Month view to instantly zoom in to the Week view.
Note: Each day box displays calendar entries associated with it. The selected date is 

highlighted with a red or black border around the date.



To move in year and month views
Use this procedure to jump forward or backward a year or month at a time.
1 Click on the Year or Month Tool button.

 - or - 
Choose Calendar - Year View or Calendar - Month View.

2 Click on the Year Forward or Month Forward Tool button to move forward.
 - or - 
Click on the Year Backward or Month Forward Tool button to move backward.



To move in week views
Use this procedure to jump forward or backward a year or month at a time.
1 Click on the Week Tool button

 - or - 
Choose Calendar - Week View.

2 Click on the Week Forward Tool button to move forward.
 - or - 
Click on the Week Backward Tool button to move backward.



To move to today's date
Use this procedure to jump to todays date while the Global Calendar is active using any 
viewthe Year, Month or Week views.
l Click on the Today Tool button.

 - or - 
Choose Calendar - Today.



To change the date of a Calendar entry
Use this procedure to change the date of an entry using the Year or Month views by simply 
selecting it and then dragging the cursor from the old date to the new one.
1. Choose Calendar - Year

 - or - 
Choose Calendar - Month.

2. Choose a calendar entry from the summary table at the bottom right corner of the 
Calendar window.

3. Drag the box or the X from the old day to the new day.
When you release the mouse button, ManagePro moves the calendar entry to the date 
you selected.

4. Press Escape to cancel the move operation.



To edit Calendar items
Use this procedure to edit any calendar item.
l Double-click the title to open a Details form for that item.

Note: If you double-click a people management item, an appropriate Details form 
appears. For example, double-clicking Mark: Input Progress Data opens a Progress
Data Details form for Mark.



To delete Calendar items
Use this procedure to delete action items.
1. Choose the Calendar item you want to delete.
2. Choose Edit - Delete

Note: Deleting a goal from the Calendar deletes it everywhere including the top level
and the responsible persons Goal Planner. 



To open a Report Planner
Use this procedure to open the Report Planner window containing pre-defined goals, people 
and action items reports.
l Choose the Reports Planner button on the ManagePro View Bar at the top of the 

ManagePro window.
The Reports Planner window opens displaying the Goals reports or the reports for the last
Related View button you clicked: Goals, People or Action Items.



To close a Report Planner
Use this procedure to close the Report Planner.
l Click on the Close Tool button at the top of the window.



To enter events
Use this procedure to enter a single event.
1. Choose Quick input - Event.

 - or - 
Click on the Event Related View button.
 - or - 
Choose Quick Input - Scheduler.

The Event Details form appears.
2. Type or choose the appropriate information.

Title Choose from the list of events or type the title of the event.
Date Enter the date for the event. The date defaults to todays date. To change it, you 
can edit the text in the MM/DD/YY format or enter the appropriate offset (such as -2d or -
3w). You can also access ManagePros calendar by double-clicking the date.
Type Choose an event type. Your choices are: Checkpoint, Meeting, Travel, Vacation or 
Holiday. You can change these event type or add additional ones. 

3. Choose OK.



To move, copy and delete information
Use this procedure to cut, copy and paste the contents of a text box or a row of information 
in summary tables. If you cut and paste a primary goal that has collapsed subgoals beneath 
it, ManagePro cuts and pastes the subgoals along with the primary goal.
1. Choose the text or rows you want to cut or copy.

You can choose text by:
l dragging across characters inside a text box to select a piece of text.
l holding down the Shift key while clicking rows or while pressing the Up and Down 

Arrow keys.
Note: For more information about ways to select text, see your Windows Users Guide.

2. Choose Edit - Cut or Edit - Copy.
The program places the information you cut or copied onto the Windows Clipboard. This 
information remains on the Clipboard until the next time you cut or copy information or 
until you exit Windows.

3. Move to the new text box or a row where you want to paste the information on the 
Clipboard.

4. Choose Edit - Paste.
Information on the Clipboard is added at the cursor, in the selected text box or at the 
currently selected row in a planner.
If you selected a piece of text before pasting, the selected text is replaced with the 
contents of the Clipboard. If no text is selected, the pasted text is inserted, pushing any 
text right of the cursor to the right.
If you selected a row, that row is pushed downward and the pasted row is inserted at the 
location you selected (a selected row is not deleted unless you use the Edit - Delete.)
Note You can copy and paste text between ManagePro and other Windows applications 

using Edit - Copy and Edit - Paste.



To undo changes
Use this procedure to undo the last change you made.
1. Choose Edit - Undo <change>

- or -
Press Alt-Backspace.

2. Choose OK in the Undo confirmation message.
- Or -
1. Choose Edit - List changes
2. Choose Undo last.



To delete rows
Use this procedure to delete one or more rows in a planner or summary table such as the 
People/Team Planner, Goal Planner or Action List.
1. Select one or more rows that you want to delete.
2. Choose Edit - Delete 

- or -
Press Ctrl-Delete.
Note: If you accidentally delete a row, you can undo the deletion using Edit - Undo or 

Edit -    List Changes.



To insert rows
Use this procedure to add additional people or goals in the planner.
To insert a row below the selected row in a planner:
1. Select a row below which you want to insert a new row.
2. Press Shift-Enter.
To insert a row above the selected row in a planner:
1. Select a row above which you want to insert a new row.

You can insert more than one row by pressing Shift-Up or Down Arrow to highlight the 
number of rows you want to insert.

2. Choose Edit - Insert.



To sort information
Use this procedure to create temporary views of the Goal Planner that are sorted by title, 
status and so on.
To sort information in a summary table:
1. Click on the Sort Tool button

 - or - 
Choose Sort from the window-specific menu.
The Select Sort Column window appears displaying two lists of the currently displayed 
columns for the summary table. You can select to sort the rows of information by one or 
two of these column titles.
Note You can change the columns that appear in a summary table - and hence the 

columns that appear in the Select Sort Column window - using the Configure Tool 
button (the wrench.)

2. Select a column title from the list and click Sort.
While a summary table is sorted, the Sort Tool button changes to indicate the information
is reorganized.

To return a summary table to its original order:
1. Click on the Sort Tool button (or choose Sort from the window-specific menu.)
2. Click on the Reset button.
3. Click OK.
To save the sorted order in the database:
l Choose the Save Current Order command from the window-specific menu. This command

alters the database to match your display.



To filter information
Use this procedure to selectively view a list of objects based upon criteria you specify.
To set up a new filter:
1. Open the window whose information you want to filter.
2. Click on the Filter Tool button.

- or -
Choose Filter from the window-specific menu.
Note: You can optionally load an existing filter by selecting it from the Load drop-down 

list box. This fills in one or more previously defined sets of criteria for you to 
accept or modify.

3. To select the first field, condition and value you want to use as a criteria for filtering:
Click on the Set #1 button
- or -
Press Alt-1 

4. Click on the menu arrow at the right of the Field box and select a field name from the 
drop-down menu.
Note: You can use the scroll bar or drag up and down in the menu to examine fields that

extend beyond the top or bottom edge of the Field menu. If you are unfamiliar 
with selecting from a dropdown list box, see your Microsoft Windows Users Guide. 
After you make a selection, it appears in the Field box.

5. Click on the menu arrow at the right of the Condition box and select a condition that the 
field must meet in order for a row to appear.
Note: The list of conditions changes based on the type of field you selected in step 4. 

For example if you select the Annual Review Date field as illustrated above, 
ManagePro offers conditions relating to time periods (such as Within Period From 
Today Of) that would not be relevant to a field like Goal Name which is a textual 
description of a goal.

6. Move the cursor to the Value box, enter a value that must be met and click OK when you 
are satisfied with your statement.
Note: If the field you selected is a text field, you can type text into the Value text box. If 

the field is a Status field or Person/Team field, for example, the Value box 
becomes a drop-down menu.
After you click OK, the conditional statement you just made appears beside the 
Set # 1 button.

7. Repeat steps 3 through 6 for the Set #2 through Set #4 buttons if necessary.
8. Select And or Or as the relationship required between two statements for a row to be 

displayed (or a match to be made.)
Note: Between each two statements, you should select whether the criterion of this 

statement and the previous statement must both be matched (select And) or 
whether either the criteria of this statement or the previous statement can be 
met for a row of information to match your criteria.

9. If you want to save the filter with a new name:
Click on the Save As button

10. To update an existing filters criteria:
Click on the Update button .
Note: Your filter name can include upper or lowercase letters and spaces.

11. Enter a name for the filter.
12. Choose OK.

ManagePro returns you to the Filter dialog box.
13. To apply this filter and return to the summary table window:

Choose OK.
Note: The Filter Tool button changes to indicate that your filter is turned on. The rows 

that appear in the summary table match the criteria you specified in the applied 
filter.



To apply an existing filter:
1. Open the window whose information you want to filter.
2. Click on the Filter Tool button

- or -
Choose Filter from the window-specific menu.

3. Select the filter name from the Load drop-down menu.
The settings for the filter appear in the Filter dialog box. You can change the filters 
criteria if necessary and then click the Update button to update that filter. Or, after you 
finish using the filter with the changes you have made, you can click Reset to clear the 
Filter dialog box without saving the changes you made to the existing filter.

4. Choose OK.
To turn off a filter:
1. Click on the Filter Tool button

- or -
Choose Filter from the window-specific menu.

2. Choose Reset.
3. Choose OK.

Note: If you have made changes to an existing filter and you click the Reset button 
without saving first, the changes are lost. If you click Cancel, the filter remains 
turned on and the Filter dialog box is closed.

_________
Related topics

Filter button



To find information in the active window
Use this procedure to find information in the active window.
1. Click on the Find Tool button 

- or -
Choose Find from the window-specific menu.

2. Select an object (a goal, action item and so on) from the scrolling list box.
3. Choose Find.

ManagePro displays the object in the active window.



To print from the Reports Planner
Use this procedure to print the Report Planner in the active window.
l Click on the Reports Planner button on the View Bar.

Note: The Reports Planner window opens displaying the Goals reports or the reports for 
the last Related View button you clicked:    Goals, People or Action Items.

l The Tool buttons let you select the destination for your report and select print options. 
You can send a report to the Printer, to a Disk or to the Screen.

l The Related View buttons let you open a different list of reports for Goals, People or 
Action Items. If you have defined custom reports, one or more Custom Related View 
buttons also appear. The currently selected Views icon appears at the left side of the Tool
buttons. 
In the Reports Planner window, you can:
l Select a report from the list and click the destination Tool button (Printer, Disk or 

Screen.)
l Click the Configure Tool button to specify report options.
l Double-click a report name to see a preview of it on your screen before printing it on 

the printer or to a file.
Note Timeline reports cannot be printed on the screen or to a file.



To save a database
Use this procedure to save the currently open database.
Save with existing filename and location
1. Choose File - Save.

ManagePro saves the current database.
Save under new filename and/or location
1. Choose File - Save as.
2. Type the new filename.
3. Keep the current path

- or -
Choose a different drive and directory.
ManagePro:
1. Saves your current work in the current database
2. Copies your data to the new database.
3. Opens the new database.



To copy a database to and from a diskette
Use this procedure to quickly make a copy of your database (which includes multiple files 
using different file extensions) to and from a diskette.
1. Choose File - Utilities.
2. Choose Transfer To/From Diskette.

The Transfer To/From Diskette window appears.
3. Choose whether you want transfer the database TO or FROM a diskette.
4. Choose the existing path or type the path indicating the disk drive containing the 

diskette.
5. Choose OK.

Note: ManagePro copies your database files to the diskette or new path using the same 
database name. After the copy, you are editing your current database, not the 
new copy.



To open a database
Use this procedure to open an existing ManagePro database.
1. Choose File - Open.
2. Choose the existing path

- or -
Choose a different drive and directory.

3. Choose a database from the list.
4. Choose OK.

Note The next time you start ManagePro, the last database you were working with is 
opened automatically to save you time.



To adjust column widths
Use this procedure to adjust the width of a column so that it shows the information of 
interest.
1. Position the cursor in a column title near the right-hand vertical separator line.

The cursor changes to a double-tipped arrow with a box in the center.
2. Hold down the mouse button and drag the column border left or right until it is the width 

you want.
As you drag the column border, it crosses above the text in any of the columns so you 
can easily see how wide or narrow you can make the column without hiding any of the 
text entries in that column.

3. Release the mouse button.
ManagePro resizes the column width.
Note If you widen a column, ManagePro pushes the information to the right over to 

make room. If all of your columns can no longer appear, a horizontal scroll bar 
appears at the bottom of the window. Use this scroll bar to scroll past the visible 
left or right edge of the chart.

To hide the scroll bar at the right side of the window:
1. Scroll right until you can see the rightmost columns right vertical line.
2. Drag the line to the left until the last column is small enough to fit in the window.



To insert columns
Use this procedure to insert a new column.
1. Open the appropriate window if necessary.
2. Choose Configure Planner from the window-specific menu such as the Planner or Action 

menus
- or -
Click on the Configure Tool button.

3. Select a View Title or enter a new title that you want to use for saving your revised report
or view.

4. Select a field in the Available Fields list that you want to appear as a column title in the 
planner or table.

5. Choose Add to add the field to the bottom of the Current Fields list.
6. Choose Save Report or Save View.

ManagePro asks you to confirm that you want to save the changes you have made to the
report or view.
If you clicked Save Report, ManagePro saves this view as a custom report in the Reports 
Planner. If you clicked Save View, your changes appear in the planner on the screen (and 
when you print the planner or summary table.)
Note You can move the selected field in the Current Fields list by clicking the up or 

down arrows just right of the Current Fields list.



To remove columns
Use this procedure to remove a column that you no longer need.
1. Choose Configure Planner from the window-specific menu such as the Planner or Action 

menus
- or -
Click on the Configure Tool button.

2. Select a field in the Current Fields list that you want to remove from the planner or table.
3. Choose Remove.

The program moves the field from the Current Fields list to the Available Fields list.
4. Choose Save Report or Save View.

ManagePro asks you to confirm that you want to save the changes you have made to a 
report or view.
If you clicked Save Report, ManagePro saves this view as a custom report in the Reports 
Planner.. If you clicked Save View, your changes appear in the planner on the screen (and
when you print the planner or summary table.)



To change the name of a field
Use this procedure to change the name of an existing field.
1. Choose Configure Planner from the window-specific menu such as the Planner or Action 

menus
- or -
Click on the Configure Tool button.

2. Select a field in the Current Fields list that you want to rename.
The column title for the selected field appears in the Column Title text box.
To rename a field in the Available Fields list, you must first add it into the Current Fields 
list and then select it in the Current Fields list.

3. Change the column title using standard Windows text editing methods.
The new title will be used elsewhere throughout ManagePro (such as in planners that use
the same title.)

4. Choose Save Report, Save View or Exit.
ManagePro asks you to confirm that you want to save the name change.
Note Changing the column title for a field also changes the title used in forms. Try to 

use as short a label as possible so your forms remain readable.



To change the terminology of options
Use this procedure to add, change and delete the names of options that can be entered in 
columns or text boxes.
Note The colors used in the Goal Status Board and People Status Board are based on the 

Goal Status and Event Proximity option list items.
1. Choose Options - Terminology.
2. Select a title from the Option Lists list.

The program displays the options that are available for the title you selected in the 
Option List Items list.

3. Select an option from the Option List Items list.
The name and optionally a description and color appear for the selected option. The color
indicated is used in status boards to visually give you the status of goals.

4. Change the name, description and color.
5. Choose Update.
_________
Related topics

Options Terminology command



To insert or add new options for fields
Use this procedure to insert or add options for a field.
1. Choose Options - Terminology.
2. Select a title from the Option Lists list.

The program displays the options that are available for the title you selected.
3. Enter a name and optionally enter a description and select a color for the new option.
4. Choose Add to add the option at the top of the Option List Items list.

You can click the up or down arrows at the left of the Option List Items list to move the 
selected option list item up or down in the list.

_________
Related topics

Options Terminology command



To create a shared database
Use this procedure to create a shared database.
1. Choose Options - Network.

Note: You must have an open ManagePro database to use this command. If you have 
not created any databases, open the SAMPLE database in the ManagePro 
folder/directory first and specify the common folder/directory.

2. Choose File - New.
3. Enter the new file name, specifying the complete path on the network disk as shown in 

the example below:
F:\NEWPRODS\93PLANS
ManagePro detects that you are creating a file on a network drive and asks you what 
type of sharing you want to provide.

4. Enter the option for the type of sharing you want.
Use Option 1 when you do not intend to give selective or full access to anyone. This 
option is the best if you are creating the database on a network not because you want to 
share it, but because that is the most convenient place to store it.
Use Option 2 when you want to store private personnel information in the database and 
prevent your team members from accessing it. This option should be used when you 
want your team to look at the overall goals and their own goals, but not see data you 
consider to be private. With this option, there is a master password for you (and perhaps 
your assistant) and an individual password for each person that will access the database.
Use Option 3 when you intend to give everyone full access to all of the information in 
your database. With this option there is only one master password that allows full access 
to all data.

5. If you select options 2 or 3, ManagePro asks you for the master password.
This is required. Enter any combination of letters and numbers up to 10 characters in 
length.

6. Enter the user name you would like to use in this database.
The default is the user name you entered when you installed the program. You may want 
to use just your first name, for example. This name appears in the list of authorized users
when you open this database in the future.

7. The database is created on the network.

If you selected Option 2, to allow your team members selective access to the database, 
you must now setup network access for each person.



To set up network access
Use this procedure to setup network access for each person in your team.
1. Select the persons name in the People/Team Planner window.
2. Click on the Details button

- or -
Press Ctrl-L.

3. Click on the Access button
- or -
Press Ctrl-A.
ManagePro asks for the master password for this database if you have not entered the 
password (by opening the file or by setting network access for a different person) in the 
last 10 minutes. This is to prevent someone from walking up to your computer and 
changing the password or access rights for one of your team members.

4. Enter the master password.
The Network Access form appears for this person.

5. To give this person access to your database, you must enter a password for them. The 
remaining fields in this form let you specify which parts of the database the person can 
see and, optionally, change.

There are five levels of access for the top level Goal Planner and for the persons own 
goal planner:
l No Access prevents viewing or changing this information.
l Read Only allows the information to be viewed in the planner and in forms but not 

altered.
l Post Progress Notes prevents the information from being altered, but the person 

can send progress messages to you. These messages can be viewed and processed 
using the Network Messages command from the View menu.

l Direct modification allows the information to be modified in the planner and in the 
form, but no new goals can be added or existing ones deleted.

l Full add/change/delete allows the information to be modified and goals to be 
added, deleted and moved.

There are two levels of access for the personnel information stored in the database:
l No access prevents the person from viewing this information.
l Read only allows the information to be viewed in the summary tables and forms but 

not altered.

There are two levels of access for the Quick Input menu, the Reports Planner and the 
Global Calendar:
l No access disables these features.
l Full access enables full access to these features.

If you have an assistant and would like to give them access to your database, you may 
either:
l Give them the master password, allowing full access to the program.
l Give them full access to Quick Input menus, the reports planner and/or the Global 

Calendar.
Use Option 1 when your assistant will be the primary user of the database, actively 
maintaining the information, printing reports and so on.
Use Option 2 when you are the primary user of the database but you want your assistant
to be able to Quick Input some progress data, a new goal for someone or an event; print 
out a report; or look at your calendar and change dates.

Note Giving team members access to the Quick Input menus, Reports Planner and Global 
Calendar may enable them to view and modify information for other people in your 



database. For example, the Global Calendar shows due dates for everyones goals and
these goals are modifiable from the calendar. Use these options carefully if you want 
to restrict your team members access to their own information.



To save a form as a template
Use this procedure to save any form as a template that contains information youre likely to 
need to retype later.
1. Open a Details form that you want to use as a template for other forms in the same 

category such as the Goal Details form.
2. Choose Form - Save As Template.
3. Enter a template title and click OK.



To copy a template into an open Details form
Use this procedure to copy the information from any template into the active form you are 
working with.
1. Open a Details form that you want to fill in the information for using an existing 

template.
2. Choose Form - Copy Template.

If you have created no templates for the kind of Details form that is active, the program 
lets you know. Templates are available for the corresponding form type. For example, a 
Progress Data Details template can only be used with the Progress Data Details form.

3. Select a template from the list and click Copy.
The program inserts the information from the template into the active form window.



To copy information between forms
Use this procedure to copy information from one Details form into another (of the same 
type) without saving the form as a template.
1. Open a Details form that you want to fill in with information from another existing form.
2. Choose Form - Copy Object.
3. Select an item from the list and click Copy.

The information from the Details form you selected is copied into the active form you are
viewing.



To set the environment options
Use this procedure to select screen colors and the time between background updates to (or 
saving of) the ManagePro database files.
1. Choose Options - Environment 

- or -
Press Alt-O-E.

2. Choose the options you want.
3. Click on OK.

_________
Related topics

Options Environment command



To set Security
Use this procedure to define a master password that must be entered before ManagePro will 
open the currently open database.
1. Choose Options - Security

- or -
Press Alt-O-S.
If there is already a master password, ManagePro asks you to enter it before you can 
change the master password.
The Security window appears.

2. Enter a master password using any combination of letters or numbers that you can easily
memorize. The password can be any number of characters.
As you type, your characters are replaced with asterisks so that no one can see your 
typing. When you press Enter, ManagePro asks you to retype the master password to 
confirm it.
If you are the only person who should know this password, use a password that only you 
might think of. For example, you might use "maserati" if this is your favorite car, but not 
if you drive one and any observant person might guess this would be your password.
If other people need to use this password, use a password that will be simple for each of 
you to remember but that wouldnt be easily guessed by others. For example, project 
code names may be appropriate or your favorite restaurant name. The trick of selecting 
a good password is one that is easy for the right people to remember and hard for 
intruders to stumble onto.
If you enter a password and later cant remember exactly how you typed it, you may 
need to contact Avantos Technical Support for help in recovering your password. Avantos 
can give you access to your file, but only if you have sent in your registration card.



To contact Avantos
Use this procedure to get help resolving a problem with ManagePro.
To send correspondence:
l Send mail or packages to Avantos at:

Avantos Performance Systems, Inc.
5900 Hollis Street, Suite C
Emeryville, CA 94608 U.S.A

To telephone, 8:30am to 5:00pm Pacific time
l Call Avantos from Monday through Friday at:

Support: (510) 654-4727
Corporate:(510) 654-4600
- Or -

l Fax Avantos from Monday through Friday at:
(510) 654-1276



To gather what you need before you contact us
Use this procedure to make sure you have the information about your computer system 
before you call Technical Support.
If you dont know the computer system information in the following list by memory, it is a 
good idea to locate each item and jot it down in the chart in your ManagePro manual before 
calling.

l Computer Model. (Compaq, IBM, etc.)
l MS- or PC-DOS version number. (must be version 3.1 or later, DOS 3.3 for PS/2 

models)
l Windows version number. (must be version 3.1 or later)
l RAM (random access memory). (4 MB RAM required)
l Available hard disk space. (5 MB available space required)
l Printer and other devices.



To solve problems in ManagePro
Use this procedure to solve a problem in ManagePro.
1. Find your problem in the following list, then try the solution.
2. If your problem is not listed, or the solution does not work, call Technical Support.

Error Messages
Could not initialize printer. Please check Windows setup
Could not open application file MPRO.ADF properly. Either it is not in the ManagePro 
directory or has been corrupted
Could not open initialization file <name>
Could not open the previous file you were using
There are not sufficient system resources to open a new window. Please close some 
existing windows or other applications first

Problems
Every once in a while the program cursor turns into an hour glass and my hard disk lights
up. I cant do anything while the cursor is an hour glass.
I copied my database to another computer disk, but ManagePro cannot open it
I have configured my Top-Level Goal Planner with the five key columns that I need to see 
using Planner Configuration. Now Id like to make this configuration a standard report in 
the Reports Planner so my assistant can print it out.
I have created a set of goals for one of my people, Barbara. Now I want to put them in 
my overall top-level goals. If I copy them and paste them, I just get duplicates.
I have lots of short term goals in my database. When they are completed, I delete them 
with the Delete command while Im in the Action List window. But then when I go to the 
Top-Level Goal Planner or to a persons goal planner, the goals are gone.
I want to extend the standard forms that come with ManagePro. How can I add a field to 
the Goal Details form or to Progress Data?



To back up the database
Use this procedure to make backup copies of your ManagePro database.
1. Choose File - Utilities.
2. Choose Archive.

The Archive command lets you make a back up copy of your existing and , optionally, 
delete all entries earlier than the date you specify.



To set up recurring events
Use this procedure to set up recurring events.
1. Choose Quick Input - Event Scheduler.

The Event Scheduler window appears.
2. Enter a title in the Title drop-down list box for this recurring event.

Title lets you enter a new title or select an existing event title that you want to edit, shift
in time or delete by clicking the down arrow.

3. Select an event Type from the drop-down list box.
Type provides several event types:    Checkpoint, Meeting, Travel, Vacation and Holiday. 
You can select one of these event types or create new types using Options - Terminology.

4. Click on the Recurring button.
The Set Recurring Event window appears.
Recurring When you click the Recurring button, ManagePro displays the Set Recurring 
Event window where you can enter a starting and ending date range and either an 
interval (such as every seven days) or specific days (such as the first Monday or every 
Friday.)

5 Enter a starting and ending date range for the recurring event to be in effect.
Scheduled dates If you add a single event, ManagePro displays the date of this event in
the Scheduled Dates list box. If you set up a recurring event, ManagePro displays each 
date for this event in this list box.
You can select one or more dates that you want to edit, shift or delete. Each time you 
click a date in this list box, the date toggles between being selected and deselected.

6 Select an interval by entering a number in the text box and clicking the appropriate date 
value:    Days, Weeks, Months, Quarters or Years.

7 Select specific days if you like and click OK.
ManagePro closes the Set Recurring Event window and adds the scheduled dates for the 
recurring event you defined in the Scheduled Dates list box. You can select one or more 
of these dates and edit, shift or delete them using the Edit, Shift and Delete buttons 
described below.
Select You can select scheduled dates by clicking the appropriate Select radio buttons. If
you select None, ManagePro deselects all scheduled dates. If you select Single, 
ManagePro select all scheduled dates for single events. If you select Recurring, 
ManagePro selects all scheduled dates for recurring events. If you select All, ManagePro 
select all scheduled dates.

Single You can repeatedly enter a single date and click Add Single to add one or more 
single dates for the selected event.

Edit button Click the Edit button after selecting one or more scheduled dates and 
ManagePro displays the Event Description window where you can change the date and 
enter a description for this event date.

Shift button Click the Shift button after selecting one or more scheduled dates and 
ManagePro displays the Shift Events window where you can specify a number of days, 
weeks, months, quarters or years that you want to shift the scheduled date.
To shift a date backward in time, enter a minus sign before the number in the Shift All 
Selected Events By text box.

Delete button Click the Delete button after selecting one or more scheduled dates and 
ManagePro removes those dates from the Scheduled Dates list box.

Add Single Click the Add Single button after entering a date in the Single Date text box 
to add one date to the selected event.



8 Repeat steps 2 through 7 if you want to enter another recurring event and click Exit 
when you finish.



To search the database
Use this procedure to search the entire database for words or phrases.
1. Choose Edit - Search.
2. Enter the word or phrase you want to search for, select any of the check boxes that can 

refine your search and click OK (or press Enter.)
Ignore Case disregards whether the characters you type are found in uppercase or 
lowercase. If you deselect this check box, the program only finds matches when the word
or phrase matches exactly. For example, if you select Ignore Case and search for "sales", 
the program would find "Sales", "SALES" and "sales".
Whole Words Only disregards portions of a word that match a word you type. For 
example, if you search for "margin" and select Whole Words Only, the program would 
skip "margins" and "marginal".
Search Notes looks for matches in your notes.
When the search is complete, a special Search Results table appears. Many different 
kinds of items can appear in this Search Results table. Double-clicking any one opens its 
Details form.



To add new status options with new colored lights for the status 
board
Use this procedure to customize the Goal Status options to suit your individual needs.
1. Choose Options - Colors

- or - 
Press Alt-O-C.
The Color Editor window appears.

2. Select "Status Lights" in the Color Group list.
You will see four default status lights - Green, Yellow, Red and Clear.

3. To create a new status light color:
Click the Add button
- or -
Press Alt-A.
ManagePro asks you for the name of the new color item.

4. Enter a descriptive name like "Blue Light".
5. Click the small colored rectangle for your new color item in both the Color and 

Monochrome color palettes.
The color/shade used on the screen depends on your preference for the 
Color/monochrome setting. You can change this setting using Options - Environment.

6. Choose Save to save your new color configuration.
7. Choose Options - Terminology.

The Terminology Editor window appears.
8. Select Goal Status from the Option List.

You should see the five default option items Not Started, Done, On Track, Behind and 
Critical in the Option List Items list.

9. You can select each one of these and change its name or its position in the list (the top 
item is the most important and decreasingly so on down the list) to suit your preference.

1.0 To add a new Status Option Item:
Click on the Add button.
Items are added to the end of the list. If you want to move the On Hold item further up in
the list, use the up and down arrows at the left of the Option Item List box.
The order of the items is important for the Goal Status roll-up.
The Status of any goal is calculated as the "worst" (that is, the furthest down on the list) 
status of all its subgoals. If you are most interested in knowing whether any goal is On 
Hold, keep this new item at the end of the list.
If you are more interested in knowing whether a goal is Behind than if its On Hold, move 
the On Hold item above the Behind item. That way if Goal A has three subgoals set On 
Track, On Hold and Behind, the calculated status for Goal A is Behind. If you kept On Hold
at the end of the list, the calculated status would be On Hold.

11. Type the name of the new item such as On Hold.
12. Select the status light color in the Color list ( such as the new Blue Light color.)
13. Click Update to record your new item.
14. Click Exit to close the Terminology Editor window.



To print the active planner
1. Choose File - Print.

- or -
Click on the Print Tool Button.

2. Select a Form Name or click Set Form to add new forms if you prefer, click Fonts to 
specify the fonts for levels in the report and click Report to specify report-related options 
such as whether to print notes. 
Filter/Sort Specifies criteria that items must match in order to be included in the report 
or if you want to select the sorting order for items in the report.
Timeline Displays the Timeline Specifications window.
Set Form Opens the Set Form window where you can define forms that you can easily 
reuse later.
Note: You can select a form name from the Available Designs list and:

l Change the units, orientation, margins, page size and spacing, and then click 
Update to permanently change those settings.

l Make a note in the Special Notes text box. This is a reminder that appears 
whenever you print. For example, Load letterhead paper.

l Select a form and click Delete to remove it from the list.
l Enter the name of a new form in the upper left name text box and click Add to

create a new form.
Fonts Opens the Font Specifications window where you can select the fonts to use for 
titles, text and hierarchical levels in the Goal Planner or Goal Timeline windows.
Note: You can select one of the levels and then select a text or title font, size and any 

combination of text attributes (bold, underline and italic) for that level. Shading 
and inverting attributes are available for the title font.
ManagePro lets you reset the fonts to the default choice of Helvetica 10 or 12 
point regular (bold, underline and italic turned off.)

Options Opens the Report Options window where you can select a variety of report 
options. 

3. Choose OK.



To print selected items
Use this procedure to print the selected rows in any planner or summary table.
1. Select the rows in a planner or summary table that you want to print.
2. Choose File - Print Selected Items.
3. Select Output Specifications options.

Filter/Sort Specifies criteria that items must match in order to be included in the report 
or if you want to select the sorting order for items in the report.
Timeline Displays the Timeline Specifications window.
Set Form Opens the Set Form window where you can define forms that you can easily 
reuse later.
Note: You can select a form name from the Available Designs list and:

l Change the units, orientation, margins, page size and spacing, and then click 
Update to permanently change those settings.

l Make a note in the Special Notes text box. This is a reminder that appears 
whenever you print. For example, Load letterhead paper.

l Select a form and click Delete to remove it from the list.
l Enter the name of a new form in the upper left name text box and click Add to

create a new form.
Fonts Opens the Font Specifications window where you can select the fonts to use for 
titles, text and hierarchical levels in the Goal Planner or Goal Timeline windows.
Note: You can select one of the levels and then select a text or title font, size and any 

combination of text attributes (bold, underline and italic) for that level. Shading 
and inverting attributes are available for the title font.
ManagePro lets you reset the fonts to the default choice of Helvetica 10 or 12 
point regular (bold, underline and italic turned off.)

Options Opens the Report Options window where you can select a variety of report 
options. 

4. Choose OK.



To print an active form
Use this procedure to print any active Details form.
1. Open the Details form you want to print.
2. Choose File - Print from the menu

- or -
Click on the Print Tool Button.
Note: ManagePro displays a message asking if you want to include notes when printing 

the form.
3. Choose Yes or No

- or -
Press Enter to accept the No default.
ManagePro begins printing the form.



To use the To Do List
Use this procedure to create a To Do List item.
1. Select the goal whose to do items you want to view or change.
2. Click the To Do's Related View button.
3. Enter a to do item title.
4. Enter the person or team responsible for achieving this to do item.
5. Enter a due date for the current to do item.
6. Enter a priority for the to do item.    1=high priority, 2=medium priority, 3=low priority
7. Choose the to do item status by positioning the cursor in the Status text box and 

pressing the question mark (?) key.
8. Select detail information for the current to do item.
9. Enter any miscellaneous notes you may have.



To use the Assistant window
Use this procedure to open and add views in the Assistant window.
1. Click on the Assistant button.
2. Click on the Configure Tool button (or choose Configure from the Assistant menu).
3. Select a view from the Available Views list and click the Add button.

ManagePro adds the view to the bottom of the Current Views list and displays the title in 
the View Title text box.

4. Edit the view title in the text box if you like.
5. Repeat steps 3 and 4 to add additional views to the Assistant window
6. Click on Save when you have finished.
_________
Related topics

View Assistant



To synchronize the extracted database with the base database or 
vice versa
Use this procedure to take you through the analysis of the changes that you made on the 
road and others may have made to the base database. If there are no conflicts, your 
changes are updated to the base database and the operation is complete. If there are 
conflicts, ManagePro asks you to resolve them by specifying whose change should be used.
1. Choose File- Utilities - Synchronize this mobile data with base.

- or -
Choose File - Utilities - Synchronize this file with mobile data,

2. Read the instructions in the Synchronize - Introduction dialog box and click on the 
Synchronize button.

3. In the Synchronize - Resolve Items dialog box, select one of the conflicting fields, such as
a goal, that has been changed both on the road and in the base database.

4. Click on the Resolve Item button to begin the process of resolving the field information 
conflict.
You need to decide which valuemobile or baseyou want to use by clicking each field at 
the top of this window and examining the details that appear for that field in the Mobile 
Information and Base Information text boxes.

5. In the Synchronize - Resolve Fields dialog box, select a field from the list at the top and 
examine the details for the Mobile and Base databases.

6. To send E-mail to the people involved in this conflicting entry:
· Click on the E-mail button

7. To print information about the conflict
· Click on the Print button.

8. T view more information depending on the context of what you are working with
· Click on the More Details button.

9. If you are ready to resolve the conflict based on what you see:
1. Select Use Mobile or Use Base.
2. Click on the OK button.

If you want to put the conflict on hold for now:
1. Select to Put on hold
2. Click on the OK button.

_________
Related topics

Synchronize this file with mobile data
Synchronize this mobile data with base



To select a Day view
Use this procedure to change the Calendar to display a day at-a-glance. You can select the 
Day view in three ways:
· Click the Day Tool button.
· Choose Day View from the Calendar menu

- or -
Press Ctrl-D

· Double-click inside the Week view to instantly zoom in to the Day view.



To install ManagePro on a network
Use this procedure to install the ManagePro application on a network server and have 
multiple people access it.
To install ManagePro to run off a network, follow the Setup procedures in the ManagePro 
Getting Started Guide, specifying a network server drive and directory as the installation 
destination. After Setup is complete, you need to turn on the Read Only attribute for the 
following files:

MPRO.EXE
MPRO.ADF
MPRO.ADN
WCFNS.DLL
WMEMLIB.DLL
DATALIB.DLL

In DOS, you can use the ATTRIB command to turn on this attribute. For example, if you 
installed ManagePro in the network directory N:\MPRO, you would type the following at the 
DOS prompt:

N:\MPRO\> attrib +r mpro.exe
N:\MPRO\> attrib +r mpro.adf
... and so on

In the File Manager, select each file and use the Properties command from the File menu to 
select the Read only option.
On each users machine that will access ManagePro, create an icon for ManagePro in a 
Program Manager group. Set the program path to MPRO.EXE in the network ManagePro 
directory and the working directory to be the network ManagePro directory.
Important All users must have full read, write, create, delete and file scan access to 

network directories where ManagePro databases are stored.



Could not open initialization file <name>
Situation

ManagePro needs to access certain control files when you first start it. The file 
<name> could not be found. This file should exist in your default ManagePro 
directory, the directory on your disk where you installed ManagePro. The Install 
program uses C:\MPRO as the default directory for ManagePro.

Solution
Examine your ManagePro directory with the Windows File Manager program or from 
DOS using the DIR command to see if the file called <name> is present. If it is 
missing, call Technical Support.
If the file <name> is in your directory, then the ManagePro program may not know 
how to find the ManagePro directory. The name of the ManagePro directory is stored 
in the WIN.INI file in your WINDOWS directory. You can examine this file using the 
Windows program SYSEDIT.
There should be a section in your WIN.INI, created by the Install program, that looks 
this:

[ManagePro]
HomePath=xxxxxxx

If you cannot find the word ManagePro in your WIN.INI file, then you should add the 
two lines above to the end of WIN.INI, replacing the xxxxxxx with the name of your 
ManagePro directory (default C:\MPRO).



Could not open application file MPRO.ADF properly. Either it is not in
the ManagePro directory or has been corrupted.

Situation
ManagePro requires special control files called MPRO.ADF and MPRO.ADN in order to 
run at all. These files are created by the Install program. They should be in your 
default ManagePro directory.

Solution
See the procedure above to look for them in your ManagePro directory. If they cannot 
be found, call Technical Support.



Could not open the previous file you were using
Situation

ManagePro stores the name of your database each time you exit the program. The 
next time you run ManagePro, it attempts to reload this database. For some reason, 
the database could not be opened.

Solution
Attempt to open your database manually by choosing the Load an existing database 
option from the Welcome to ManagePro screen or using the Open command from the 
File menu. If these produce the same error message, examine the directory where 
your database is located with the Windows File Manager program or from DOS using 
the DIR command. You should see at least two files with the name of your database. 
If you called your database SALES then you should find both

SALES.MPD
SALES.MPX

and you may also see two additional files
SALES.MPS
SALES.MPU

If SALES.MPD or SALES.MPX do not appear in your directory, then a key database file 
has been deleted. If you are missing just the MPX file, call Technical Support. There 
may be a procedure for recovering your data. If both files are missing, they may have
been deleted accidentally. See your DOS manual (version 5.0 or greater) for help 
using the UNDELETE command or check to see if you have any disk utilities such as 
the Norton Utilities that can assist in undeleting files.



Could not initialize printer. Please check Windows setup
Situation

When you ask ManagePro to print information onto your printer, the program asks 
Windows to prepare the current default printer for output. This message indicates 
that Windows could not prepare your printer.

Solution
If you have a dot matrix printer or any directly connected printer (plugged into your 
computer) that has a button or switch labeled On Line or Off Line, verify that the 
printer is On Line, which means able to receive data from the computer.
If the printer appears to be on line, check your Windows printer setup. You can set up 
your printer using the Control Panel program that comes with Windows. See the 
Microsoft Windows Users Guide for information about how to set up your printer.
The easiest test to see if the problem is in Windows or in ManagePro is to run Write, 
the simple word processor that comes with Windows. Type a few lines, then choose 
the Print command from the File menu. If Write can print successfully and ManagePro 
cannot, call Technical Support. You can exit Write by choosing Exit from the File menu.



There are not sufficient system resources to open a new window. 
Please close some existing windows or other applications first

Situation
Windows has a built-in limitation to the number of programs and windows you can 
have open at the same time. This limitation is known as System Resources. 
ManagePro has detected a low amount of resources available and cannot open a new 
window.

Solution
Exit other applications and close other ManagePro windows to free up system 
resources. If it is not convenient for you to exit other applications, you may want to 
consider upgrading to Microsoft Windows version 3.1, which eases the limitation on 
System Resources.



"I want to extend the standard forms that come with ManagePro. 
How can I add a field to the Goal Details form or to Progress Data?"

Solution
ManagePro comes with user-definable fields for the goal records, progress data and 
many others. You can rename these fields and add them to forms using the Form 
Configuration tool explained in the Customizing Details Forms section in Chapter 8, 
Customizing ManagePro. They can also be added to planners and summary tables 
using Planner Configuration, also described in Chapter 8.



"I have configured my Top-Level Goal Planner with the five key 
columns that I need to see using Planner Configuration. Now Id like 
to make this configuration a standard report in the Reports Planner 
so my assistant can print it out."

Solution
You can save any planner configuration as a report using the Planner Configuration 
command. Click the Save Report button to specify the report title, whether to print 
the data in columns and to which report category you want to add the report. The 
next time you open the Reports Planner, your new report will appear in the category 
you selected.



"I copied my database to another computer disk, but ManagePro 
cannot open it"

Solution
There are several files that make up one ManagePro database. All of them must be 
copied for your database to be readable by ManagePro. The best way to copy a 
database is using the Transfer command from the Utilities submenu (File menu.) If 
you want to copy manually, be sure to copy all files with the name of your database, 
not just one.
If your database is called SALES, open the folder where the database files are stored 
and choose By Name from the View menu. Then, drag or Shift-click to select all the 
files whose names begin with SALES. Finally, drag the files to a different disk or 
volume.
If your database is called SALES, use the following command in DOS to copy the 
database to a diskette:

COPY SALES.* B:



"Every once in a while the program cursor turns into an hour glass 
and my hard disk lights up. I cant do anything while the cursor is an 
hour glass."

Solution
ManagePro has a security feature that makes a backup copy of your database 
periodically. You can control the frequency of the backup using the Environment 
command from the Options menu. If you do not want backup copies made during 
your ManagePro session, set the Backup Frequency option to 0 (zero) minutes.



"I have created a set of goals for one of my people, Barbara. Now I 
want to put them in my overall top-level goals. If I copy them and 
paste them, I just get duplicates."

Solution
Use the Insert Linked Copy command from the Edit menu. Go to the Top-Level Planner
and move the cursor to the row where you want Barbaras goals to be inserted. 
Choose the Insert Linked Copy command from the Edit menu. A list of all goals in the 
database sorted by Person/Team appears. You can highlight one or many goals, then 
press OK. Barbaras goals are linked into the Top Level Goal Planner at the cursor.

Note If you create a link to a goal that already had a parent goal above it, the goal in 
the Top-Level Planner appears in gray. This lets you know that it is just a linked 
copy.



"I have lots of short term goals in my database. When they are 
completed, I delete them with the Delete command while Im in the 
Action List window. But then when I go to the Top-Level Goal 
Planner or to a persons goal planner, the goals are gone."

Solution
Do not delete goals using Delete from the Edit menu. No matter which window you 
are in, the Delete command removes the goal from the database, just like choosing 
Delete in a spreadsheet or Cut in a word processor. If you want to remove a goal from
the Action List, mark its status as Done and choose Hide Done Items from the Action 
menu. When this command is check marked, only items whose status is not Done 
appear. You can use the same option in your Top Level and peoples goal planners too.



To control goal roll-ups
ManagePro has an automatic roll-up feature for three key fields in the goal record: Goal 
Status, Start Date and Due Date. These fields are usually calculated for any goal based on 
values in its subgoals.
For example, if Goal A has two subgoals, A-1 and A-2, then the value of the Status field (Not 
Started, Done, On Track, Behind or Critical) is rolled up from A-1 and A-2. If A-1 is On Track 
and A-2 is Behind, then Goal As status is calculated to be Behindbecause you want to know 
the worst status of all the subgoals. If goals A-1 and A-2 have subgoals, the same calculation
takes place. Therefore, status is usually calculated using the lowest level goals (only those 
goals that have no subgoals beneath them.)
Start and Due Dates for goals work in very much the same way. The Start Date for a goal is 
calculated as the earliest date that can be found in all its subgoals. If goal A-1 has no start 
date but a due date of May 3 and goal A-2 runs from June 1 to July 30, the start date for Goal
A is May 3. Although May 3 is a due date for A-1, it is the earliest date in all of Goal As 
subgoals, so ManagePro uses it as the calculated start date of Goal A. The end date for Goal 
A is the latest date found in its subgoals, July 30.
Sometimes it can be valuable to override the normal roll-up of status and dates. For 
example, if you temporarily want to focus your attention on a goal even though none of its 
subgoals are off track. Or if you want to set the due date for a goal to extend beyond the 
due dates of any of its subgoals. This is easy to do in ManagePro.
You can freely change the status field, start or due date for a goal in a planner or a form. If 
the goal has subgoals, ManagePro displays a warning message reminding you that the field 
you have changed is normally rolled-up. You can choose to continue with overriding the roll-
up, cancel the change to that field (leaving all other changes in place) or cancel the entire 
update.
If you choose to override, then ManagePro disables the automatic roll-up and uses your 
specific value instead. So you could go to the Goal Planner and change the Status of Goal A 
to Critical, even though A-1 is On Track and A-2 is Behind. You could also set Goal As due 
date to August 15th, overriding the July 30 date in goal A-2.
In the Goal Status Board, the Status field is used to drive the color of rectangular lights, 
usually green, yellow and red. When you override the normal roll-up, ManagePro takes the 
left corner of the rectangle and shows you what color the light would be without any manual 
overrides in place.
Thus if you override Goal A to be Critical, you would see a red rectangle with the left corner 
in yellow, to tell you that the normal roll-up of this goals status would be yellow.
It is also easy to turn off the override you have in place. There are two approaches, one for 
the Goal Planner and one for the Goal Details form.
In any Goal Planner, you can remove an override by moving the cursor to the correct 
column, pressing Delete, then pressing Enter. For example, moving to Goal As status column
(Critical), pressing Delete, then Enter resets it to the normal roll-upBehind. The same holds 
true for the due date column.
If you are looking at the Goal Details form for Goal A, you can delete the text in the Due 
Date field to remove the roll-up there. But because the Status field is not a text entry but a 
selection from an existing list, you must use the Special button to get change the override 
for goal status.
The Special form for a Goal has two check boxes. One indicates whether the status for this 
goal should have manual override turned on. From the Special form, you can turn off this 
check box to remove any override of the Goal Status field.
The other check box in the Special form has a different purpose. It allows you to ignore this 
goal in roll-ups.
For example, if Goal A-2 is Behind but you have a plan in place to fix the problem and you 



want to know if anything else gets off track, you could select the Ignore In Roll-ups check 
box. When Goal A-2 is ignored, the status of Goal A becomes calculated as On Track. On the 
Goal Status Board, the Goal A light will be green, but one corner of the light will be yellow, to
remind you that there is something Behind in Goal As subgoals.



To customize the Goal Status field
If you use the Goal Status field in the Goal Details form and the Goal Status Board tool 
frequently, you may want to understand in greater detail how ManagePro maintains the list 
of status options and how they are connected to the colored lights in the Status Board.
The Goal Status field can be set to one of several status options. By default, ManagePro calls
these options Not Started, Done, On Track, Behind and Critical.
The Done option is very important because it is used in planners and the Action List to hide 
goals that have been completed. The other options correspond to Green, Yellow and Red 
lights on the Goal Status Board.
With ManagePros configuration tools you can customize the Goal Status options to suit your 
individual needs.
_________
Related topics

Status options, adding new with new colored lights for the status board



To enter dates
Because ManagePro helps you manage both your people and goals, it tracks, and in fact 
generates, many dates. There are dates associated with:

l Goals that you establish with your subordinates (start dates, due dates and interim 
checkpoints.)

l People management tasks (getting performance data updates, giving feedback and 
coaching, giving performance reviews and recognition and so on.)

l Commitments that you, as manager, make to support your subordinates.
l Other Action items that you ask ManagePro to track.

You can enter dates manually in the MM/DD/YY HH:MM AM/PM format. For example, 
September 14, 1992 at 10:00 a.m. could be entered as:

l 9/14/92 10:00 am
l 09/14/92 10
l SEP 14 10 am (ManagePro defaults to the current year)
l Next Mon (if that is next Mondays date)

You can enter a time following any date, such as 4:00 pm. If you enter only a 6 after the 
date, ManagePro assumes you mean 6 p.m. If you enter only a 7 after the date, ManagePro 
assumes you mean 7 a.m. (this is the breaking point for the default AM/PM setting.)
You can also enter a date offset from todays date (for example, entering -3d means three 
days ago, entering +5w means in five weeks and entering +2m means in two months.) 
Alternatively, you can set a date using ManagePros calendar by double-clicking any Date 
text box.



To use keyboard shortcuts
The following keyboard shortcuts are available in ManagePro at different times as indicated.
Note In ManagePro windows that are resizable and have Minimize and Maximize buttons in 

the upper right corner, keyboard shortcuts are generally Ctrl-<letter>. In dialog 
boxes (the non-resizable windows with text, OK and Cancel buttons), shortcuts are 
generally Alt-<letter>.

Moving around
Selecting information
Editing text or rows
Changing the appearance of information
Outlining goals
Working with ManagePro windows



To move around
The following keyboard shortcuts are useful for moving the cursor or to find or view different 
information in ManagePro.
To do this: Press: While this window is active:
Browse backward in 
Advisor contents Ctrl-B Advisor windows
Browse forward in 
Advisor contents Ctrl-F Advisor windows
Find event Ctrl-I Calendar and planner windows
Go to previous topic viewed Ctrl-P Advisor windows
Go to search topics list Ctrl-S Advisor windows
Go to table of contents Ctrl-C Advisor windows
Move cursor down one row Enter Planners and summary tables
Move to next/previous column Tab/Shift-Tab Planners and summary tables
Move up or down a row Up/Dn Arrows Planners and summary tables
Move up or down a screen PgUp/PgDn Planners and summary tables
Move up/down a line 
(scrolling text box) Up/Dn Arrows Advisor windows and forms
Move up/down a page 
(scrolling text box) PgUp/PgDn Advisor windows



To select information
The following keyboard shortcuts are useful for selecting information in ManagePro.
To do this: Press: While this window is active:
Select a different date Arrow keys All views of calendar
Select from drop-down list box ? Selection list box
Select multiple rows Shift-Up/Dn Arrows Planners and summary tables
Select next item Keypad + Selection list box
Select next/previous text box/button
(except in scrolling text box) Tab/Shift-Tab All forms
Select or deselect individual rows Ctrl-click Planners and summary 

tables
Extend current selection Shift-click Planners and summary tables
Select previous item Keypad - Selection list box
Select the default button 
(except in scrolling text box) Enter All forms and dialog boxes
Select this date in 
previous/next month PgUp/PgDn Year or month view of calendar
Select this day in 
previous/next week PgUp/PgDn Week view of calendar
Select todays date Ctrl-T All views of calendar



To edit text or rows
The following keyboard shortcuts are useful editing text or rows of information in ManagePro.
To do this: Press: While this window is active:
Copy the selected text or rows Ctrl-Insert All windows
Cut the selected text or rows Shift-Delete All windows
Delete the selected text or rows Ctrl-Delete All windows
Edit notes Ctrl-N All windows
Insert new object below cursor Shift-Enter Planners and summary tables
Paste text or rows at the cursor Shift-Insert All windows
Undo last change Alt-Backspace All windows



To change the appearance of information
The following keyboard shortcuts are useful for changing the appearance of information in 
planners or summary tables.
To do this: Press: While this window is active:
Filter to selectively display rows Ctrl-F Planners, summary tables and calendar
Month view of calendar Ctrl-M Year or week view of calendar
Sort to reorganize rows Ctrl-S Planners and summary tables
Week view of calendar Ctrl-W Year or month view of calendar
Year view of calendar Ctrl-Y Month or week view of calendar



To use goal outlines
The following keyboard shortcuts are useful for outlining the goals in the Goal Planner 
windows.
To do this: Press: While this window is active:
Collapse all goals Ctrl-C Goal Planner, Goal Timeline
Collapse current goal Ctrl-Keypad- Goal Planner, Goal Timeline
Demote current goal Ctrl-D Goal Planner, Goal Timeline
Expand all goals Ctrl-E Goal Planner, Goal Timeline
Expand current goal Ctrl-Keypad+ Goal Planner, Goal Timeline
Expand to show # levels Ctrl-1,2,3É9 Goal Planner, Goal Timeline
Promote current goal Ctrl-P Goal Planner, Goal Timeline



To work with ManagePro windows
The following keyboard shortcuts are useful for opening, closing and rearranging windows in 
ManagePro.
To do this: Press: While this window is active:
Cascade windows Shift-F5 All windows
Close a window Escape All windows
Help about program F1 All windows
Help from advisor Shift-F1 All windows
Tile windows Shift-F4 All windows
View Details form for 
selected object Ctrl-Enter Planners and summary tables





Assigning more than one person to a goal, progress, to do item
ManagePro now provides you with the ability to assign goals and other items to more than 
one person. 
You can do this in any "Who" field in any view. You enter the names of the people you want 
to assign the goals or items, separated by a semi-colon. You can also double click on the 
"Who" field, then choose one or more people from the list. 



Moveable Tool Bar
ManagePro has a new interface feature to provide quick mouse access to common features: 
the Tool bar. 
The Tool Bar consolidates all of the actions buttons into one moveable bar that you can 
display at the top, bottom, left or right-hand side of the screen. This gives you more screen 
to view multiple windows. If you prefer, you can display the Tool buttons in each open 
window.
The Tool buttons allow you to manipulate information in the active window. For example, the 
Tool Bar offers buttons such as the Find, Filter, Sort, Configure, Print, Document and View As 
buttons.
The Tool buttons that are available change depending upon which ManagePro window is 
active. You can hide the Tool Bar by choosing the Options|Display command and removing 
the check mark beside that option. ManagePro adds the appropriate tools inside each 
window, near the top and just below the windows Title Bar. If you keep the check mark 
beside the Tool Bar option, you can also choose the location where the Tool Bar appears:    
Top, Right, Bottom or Left.



Message Bar
The Message Bar appears across the bottom of the ManagePro window and it displays brief 
Help information that describes the object you point to or where the insertion point/cursor is 
located.
You can choose if or when, ManagePro should display Help messages as you move the 
mouse over areas of the screen by choosing the Options|Display command and keeping the 
check mark beside the Message Bar option. Your options are:    Dont Show Messages, On 
Mouse Move or On Option-Click (ManagePro for Macintosh)/On Right Click (ManagePro for 
Windows.)



Right Mouse Click Menu
In any view, you can press the right mouse button on any object (Goal, Person, etc.) to 
display the right mouse menu. Using the right mouse menu you can quickly edit, print, mail 
or attach documents, which makes the program faster to use.



To Do List and Goal To Do List
The new To Do list and Goal To Do list enable you to easily input, delegate, and track the 
small detailed tasks that are often required to support goals and people management.
The To Do List is a supplement to the Action List and lets you focus on to do items, where the
Action List lets you work with all kinds of action items: to do items, events, goals, people 
management reminders and commitments. In the To Do List, you can enter new to do items 
directly. The Global To Do List contains all to do's you have created, either with Quick Input 
To Do Item, adding a To Do from the action list, or using the to do list for individual goals. You
can quickly sort your to do items in the global To Do list using the Change View tool button.
When you click the To Do button in the Goal Planner window, the To Do List window opens 
displaying a summary table of any previously entered to do items for the selected goal. This 
summary table gives you an overview list showing the title of the to do item, the name of 
the person or team who is associated with the item, the due date, priority and status of the 
item. As you create new to do items, the Who and Due Date fields default to those for the 
related goal. You can change these values manually if you need to.



Day at a glance calendar and week and day printouts
The Global Calendar allows you to track meetings and other events within a day. It is not 
intended as a full-fledged appointment book or group scheduler, but it can extend your 
ability to rely on ManagePro as your primary management tool.
It is divided into three areas:
n The main calendar section, which offers the ability to view and change dates in the 

database.
n A daily event summary table showing all activities on the currently selected date (not 

available in the Week or Day views since you see all daily events there anyway.)
n A Display check box section that lets you tell ManagePro to selectively display goal dates, 

people management activities, to do items and management commitments.
Click on the Calendar tool to display the Calendar. You can use the Calendar menu to move 
view years, months weeks or days, jump to today and change to a year/month/week/day-at-
a-glance calendar.
Note The personal Calendar available for a selected person or team in the People/Team 

Planner window by clicking the Calendar Related View button works just like the 
global Calendar. However, it displays information related to the selected person or 
team rather than across-the-board planning information.



Linking with Other Applications - DDE
ManagePro for Windows provides DDE support with two commands: Copy Link and Paste 
Link which you can choose from the Edit menu. These DDE commands allow point-to-point 
sharing of information between ManagePro for Windows and other Windows applications that
support DDE.
With a simple copy and paste operation, you can create permanent links between 
ManagePro and your spreadsheet, word processor, database and other applications. For 
example, you can easily link current sales or productivity numbers from a Microsoft Excel 
spreadsheet to a field in a ManagePro goal, allowing easy tracking of actual progress.
You control the kind of updates you want to take place between information from other 
applications that you have pasted into a ManagePro database using ManagePros Links 
command from the File menu. For example, you can decide how often the linked information 
should be updated or update it yourself at any time.
Note ManagePro does not control the updating of information that you have copied from 

ManagePro into other applications using the Copy Link command. 



Linking with Other Applications - Document Attachment
Document attachment allows you to associate one or more external disk files, or documents,
with any object in ManagePro, such as goals, progress notes, and performance reviews. 
This feature lets you use ManagePro as a home base. Within ManagePro, you can quickly 
start (or launch) other applications from the Attached Documents window in the context of 
their on-going goal and people management activities. Financial projections, product 
proposals, key customer lists and so on can, therefore, become more clearly organized by 
the structure of the goals being addressed.
You can access the Attached Documents window using
n the Documents command from the Edit menu,
n the Tool pop-up menu/drop-down list box (point to an items title and Option-click or click 

the Right mouse button),
n the Documents icon that appears left of an item which has one or more attached 

documents,
n the Documents Related View button which is available in several windows
The Attached Documents window lets you attach, delete or edit a document for the selected 
item. For example, you might want to attach a spreadsheet, graphic image or word 
processing file. You can also launch the application that created the selected document in 
the list.



Direct E-Mail Support
You can quickly send E-Mail messages (on VIM and MAPI compliant systems) based on 
ManagePro information. Quick communication on a goal or progress note is just a click away.
ManagePro will format a text message based on the current items selected in the current 
view, auto-address the message based on the "who" fields of the item selected, and launch 
the appropriate mail system interface to allow annotation. If there are documents attached 
to any of the selected items, you can choose to attach those to the message as well.
In most ManagePro views you can select one or more items and mail them by choosing the 
E-mail command from the File menu or by pressing the Mail button. In order to send E-mail 
from within ManagePro, you must have one of the    following electronic mail systems:
n Microsoft Mail version 3.0 or later
n Lotus ccMail version 1.1 or later
You can specify which mail system you are using at any time using the Environment 
command from the Options menu. 
See Chapter 7 in the Reference Manual for additional information on setting up E-mail.



Simultaneous Multi-user Access
You can now set up your databases to enable workgroup collaboration and shared team 
access. This means an unlimited number of people can be editing the same database at the 
same time. Each ManagePro object - goal, progress note, feedback note, etc. - is individually 
locked when a detail form is brought up or you begin editing it in a planner. If another user 
attempts to edit the same object, a message appears informing them who has it locked and 
since when. 
When you create a new file, ManagePro asks what type of file sharing you want to use:
n No one else will access this file means only you will have access to the database.
n People will have access to selected parts of this file means you want to let other members 

of your team access selected parts of the database.
n People will have full access to this file means everyone with the password can log into the 

database and have full access to the entire database.



Mobile computing support
It is becoming more and more common for managers and team members to spend 
significant time with portable computers that are not always attached to a network in the 
office. This presents a significant challengehow to share information in common files on the 
network and still allow people with portable computers to make changes on the road. 
Eventually, wireless networks that let you connect to your network while on the road will be 
commonplace. In the near term, applications like ManagePro need to assist you in this 
process.
The Mobile Computing commands in ManagePro allow you to extract a copy of the shared, 
network database onto your portable computer, work on that database while youre on the 
road, then synchronize your changes with others that people have made to the database on 
the network. This powerful feature ensures that on an item-by-item basis, no information is 
lost or overwritten accidentally.
We are using the following terminology in our Mobile Computing support:
Mobile Computing Term Definition
Base database the database residing on the network that multiple people 

share.
Extracted database the database on a portable machine, worked on by one person 

on the road.
Extract the operation of making a copy of the base database on a 

portable computer.
Synchronize the operation of updating a base database with new information

in an extracted database allowing for conflict resolution.
Conflicts changes made in both the base database and extracted 

database that are in conflict; e.g., you change the Due Date to 
6/1/94 and Mark changes it to 4/1/94.

Resolve decide which information is correct; should Due Date be 6/1 or 
4/1?

_________
Related topics

Extracted database, synchronizing with the base database or vice versa



Cross-platform Support
Many organizations, and almost all large ones, have heterogeneous computing 
environments. Any workgroup or team collaboration tool must support the major personal 
computer platforms. ManagePro for Macintosh and ManagePro for Sun (SPARC) will enable 
you to implement ManagePro broadly in your organization without requiring pure Windows 
installations.




